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Voorwoord 
  
 
. . . Webloggen, Vloggen, FotoF****n, podcasten, YouTube, MySpace en Web 2.0 . . . zijn slechts 
enkele termen en namen van websites die het afgelopen jaar prominent in het nieuws waren.  
 
De basis van het WWW is echter nog steeds de HTML; deze afkorting staat voor 'Hyper Text Markup 
Language'. In de cursus basis webdesign word je bekend gemaakt met de mogelijkheden van deze 
opmaak-taal. We starten de cursus met het 'echte' html werk, maar het meeste werk wordt verricht 
met behulp van het programma Dreamweaver. 
De rode draad door de cursus is het maken van een kleine website aan de hand van een door de 
docent gestelde opdracht of aan de hand van een eigen idee. De benodigde kennis en vaardigheden 
die je nodig hebt om dit te bereiken wordt aangereikt in de vorm van een aantal kleine opdrachten en 
oefeningen. Ook de vraag wat is een mooie of lelijke, een goede of slechte website komt aan de orde: 
Hoe zijn tekst en beeld op het web geintegreerd, wat zijn de nieuwe ontwikkelingen, hoe verhouden 
vormgeving en fuctionaliteit zich tot elkaar. 
 
Ten aanzien van deze reader het volgende . . .    
Deze reader is helaas niet voor de volle 100% up to date. De basisbegrippen die in deze reader staan 
zijn echter nog steeds actueel. Vandaar dat wij dit boek toch aanbieden binnen de cursus. 
 
Zowel de reader als het digitale lesmateriaal voor de cursussen webdesign  worden op dit moment – 
parallel aan de lopende cursussen – (door) ontwikkeld. Vragen of opmerkingen t.a.v. deze reader en 
het beschikbare lesmateriaal kun je  natuurlijk aan je docent doorgeven of stuur een mailtje naar 
d.emmen@skvr.nl. Elke bijdrage aan de ontwikkeling of verbetering van onze cursussen wordt zeer 
op prijs gesteld. 
 
Met vriendelijke groeten & veel plezier tijdens de cursus, mede namens het BeeldFabriek team,  
 
Daan Emmen 
Stafdocent digitale media 
SKVR BeeldFabriek
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10 webdesign regels 
 
In alle professionele vakgebieden zijn er regels en wetten. In het vakgebied Webdesign zijn deze 
regels nog 'in ontwikkeling'.  .. denkt men.. 
 
In de praktijk blijkt echter dat het vakgebied Webdesign zich niet aan algemeen geldende user 
interface design en beeldschermcommunicatiewetten kan onttrekken.   
Begrippen als tekstgrootte en navigatiestructuur zijn voor alle digitale media hetzelfde.   
Het Web heeft echter ook nog zijn eigen (spel)regels.  Deze zijn specifiek voor het medium en aan 
een continue verandering onderhevig.  De technologie schrijdt voort en de vormgevers worden steeds 
inventiever in hun digitale creaties.  Toch is het duidelijk dat er basisregels zijn die een sitebouwer 
dient te respecteren. 
 
Regels of wetten 
Een goed gemaakte webpagina bezit een aantal eigenschappen die ervoor zorgen dat gebruiker de 
geboden informatie efficiënt tot zich kan nemen.  Die eigenschappen betreffen zowel de fysieke 
overdracht van enen & nullen via het modem naar de computer van de gebruiker, als de 
communicatie van de feitelijke inhoud van de pagina.  Uiteraard zijn de gepresenteerde regels geen 
dwingende wetten.  Met de voortdurende innovatie van het medium is geen enkel huisje meer heilig, 
maar dat neemt niet weg dat er een aantal vormgevingsaspecten zijn waar de webdesigner rekening 
mee dient te houden.  Het opvolgen van de adviezen kan men laten afhangen van de specifieke 
doelstelling van de site. 
 
 
Regel 1: Bereid eerst een structuur voor  
Voordat je de muis ter hand neemt, is het goed om eerst een pen of potlood in te zetten.  Een simpel 
storyboard of een diagram waarin de verschillende onderdelen van de site zijn aangegeven is vaak al 
voldoende om structuur in de informatie aan te brengen.   
 
Regel 2: Zet waardevolle inhoud op elke pagina  
Een tweede onderdeel van de web-planning is het vergaren van content.   
Wat gaat de site communiceren? Welke informatie wordt getoond en in welke vorm?  En vooral, maak 
geen onnodige pagina's met louter links naar weer volgende webpagina's.  De bezoeker is op zoek 
naar informatie.  Zorg er dan ook voor dat op elke pagina betekenisvolle informatie te vinden is, die 
afgestemd is op de gebruiker van de site. 
 
De concurrentie op het Web is groot en het vergaren van informatie is bijzonder laagdrempelig (met 
een klik is je bezoeker weer verdwenen). Je zult je publiek dus waar voor zijn geld (tijd = geld) 
moeten geven.   
 
Regel 3: Test de site vooraf en tijdens 
Maak in de ontwikkelfase indien mogelijk gebruik van een 'gebruikers-test'.  In dit proces worden 
potentiële bezoekers van de site vooraf met de vorm en inhoud geconfronteerd en om hun mening 
gevraagd.  De uitkomsten van deze gebruiker-test kunnen dan weer gebruikt worden bij het uitwerken 
cq. verbeteren  van het ontwerp.   
Het is logisch dat de testpersonen qua profiel aan moeten sluiten bij de doelgroep van de site. 
Uiteraard is dit een investering die zich pas op termijn terugverdient en niet echt van toepassing is 
voor een privé-pagina.   
Een commerciële organisatie doet er meer dan goed aan om een 'gebruikers-test' in het 
ontwikkelproces op te nemen.   
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Tip : een test kan zeer goed 'online' worden uitgevoerd door een eerste ontwerp op het web te zetten 
en aan de site nog een vragenlijst (form) toe te voegen.  
 
Regel 4: De eerste indruk is (alles) bepalend 
De homepage is de belangrijkste pagina van de site.  Afhankelijk van de indruk die deze pagina 
maakt, bepaalt de bezoeker of hij doorsurft of afhaakt.  Zorg er dan ook voor dat het nut van de site of 
de doelstelling duidelijk zichtbaar is.  'Op deze site vindt u informatie over...' dient niet alleen in woord 
maar ook visueel gecommuniceerd te worden.  Het is de kunst om een goede balans te vinden tussen 
de introductieboodschap en de navigatie elementen naar de vervolgpagina's toe. 
Let wel, de kwaliteit en helderheid van de navigatie is net zozeer van belang als de visuele indruk die 
de site maakt. Belangrijke links dienen helder gecommuniceerd te worden. 
 
Regel 5: Gebruik technologie met verstand 
Het is verleidelijk om de allernieuwste webtechnologiën in een site op te nemen.  De belofte van een 
multimediaal medium dient nu eenmaal waar te worden gemaakt.   
 
Helaas is de doelgroep 'not amused' als deze met een gebroken icoon van een ontbrekende plug-in 
geconfronteerd wordt.  Om nog maar te zwijgen over een crash die door een experimentele applet 
veroorzaakt wordt.  De onduidelijkheden omtrent uniforme webstandaarden en de verschillende 
browser- en systeemversies vereisen enige terughoudendheid bij het inzetten van state-of-the-art 
technologie. 
 
Regel 6: Bied keuzes, bewust en onbewust 
Als men toch persé gebruik wil maken van specifieke plug-ins of zware graphics, is het zaak om de 
bezoeker de keuze te bieden om de site te kunnen beleven op een manier die hij prefereert.  Een 
introductie gemaakt in Macromedia Flash is pas echt fraai als er door middel van een 'browsercheck' 
vooraf is gecontroleerd of de bewuste plug-in ook geïnstalleerd is.  Zo niet, dan dient automatisch een 
vervangende afbeelding te worden getoond.  Een site die gebruikmaakt van 'zware' afbeeldingen, 
moet ook een 'licht' alternatief hebben.  Bij een site met een hoog servicegehalte, zoals een online 
beleggerssite, is dit een absolute must vanwege de tijdwinst! 
 
Regel 7: Design met mate en intelligentie 
Hoewel driekwart van de nederlandse bevolking aangesloten is op breedband internet, is dit geen 
vrijbrief om de site alsmaar groter (in kilo- en megabytes) te laten worden. 
 
De bezoeker van je site wil de informatie snel op zijn scherm hebben, het liefst binnen enkele 
seconden!  Uiteraard kan dat nooit als harde eis gesteld worden vanwege alle externe 
omstandigheden waar een webdesigner mee te maken heeft.  Dat neemt echter niet weg dat een 
pagina dusdanig opgezet dient te worden dat de gebruiker onmiddellijk 'iets' op zijn scherm krijgt 
nadat de verbinding is gemaakt.  De gebruiker moet altijd 'feedback' krijgen op zijn acties. 
 
Dat betekent voor de site ontwerper dat de pagina (technisch) zodanig opgezet dient te worden dat er 
alvast tekstuele informatie zichtbaar is die de bezoeker tot zich kan nemen, en dat vervolgens het 
beeld (de afbeeldingen) binnenkomt afhankelijk van de snelheid van de Internet connectie. 
 
Tip : Een voorwaarde hiervoor is dan ook dat je bij alle afbeeldingen de breedte én hoogte vermeldt.  
De reden hiervoor is dat de browser deze data nodig heeft om de HTML-pagina in tekst weer te 
kunnen geven. Nadat de tekst ingelezen is, worden dan een voor een de bijbehorende afbeeldingen 
getoond.  Een tabel die gebruikt wordt om de gehele pagina bij elkaar te houden, kan het laden van 
de pagina ook aardig vertragen.  
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Regel 8: Een heldere en consistente navigatie 
Hoe fraai de eerste indruk ook is, de homepage is slechts de start van het virtuele bezoek.  Op de 
vervolgpagina's staat vaak de eigenlijke informatie.  Dat betekent dat de bezoeker op een heldere 
manier de content moet kunnen bereiken.  Tegelijkertijd betekent dit ook dat de subpagina's 
eenzelfde navigatiestructuur moeten hebben als de homepage.   
 
De samenhang van het totale beeld zorgt ervoor dat de gebruiker zijn weg zonder hindernissen kan 
vinden, daardoor langer op de site zal vertoeven en genoeg redenen heeft om naar de site terug te 
keren.  De navigatie is een belangrijk deel van de beleving van de site. 
 
Als de bezoeker de homepagina heeft verlaten en door de site begint te clicken, is het van belang dat 
duidelijk is waar in de site-hierarchie men zich bevindt en hoe men terug kan keren naar de 
homepage.  Ook de relatie met de andere sub- of themapagina's moet helder zijn.   
 
Regel 9: Webdesign is dynamisch 
Een website is als een levend organisme; er worden continu pagina's aan toegevoegd en verwijderd.  
Ook de vormgeving dient doorlopend kritisch bekeken te worden.  Kan de pagina 'lichter' (in Kb) 
worden gemaakt?  Zijn er online trends die we moeten volgen waardoor de site aangepast moet 
worden?  Niet alleen het gedrag van de bezoekers verandert, maar ook de omstandigheden 
waaronder de pagina's bekeken worden.  Monitorgroottes groeien, modemsnelheden nemen toe, 
maar helaas ook de online drukte.  Stilstand is achteruitgang, vooral in webdesign.  
 
Tip : Een specifieke bron van informatie waar met enig invoelingsvermogen naar gekeken moet 
worden, is de statistiek van de site.  Er zitten bijzonder waardevolle gegevens in de statistische data 
die in het ontwerp- en onderhoudsproces kunnen worden opgenomen.  Rubrieken en functies die 
voor de bezoeker hoog in de prioriteitenlijst staan, vindt men ook in de statistieken terug.  De opmaak 
kan dientengevolge worden aangepast. 
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Regel 10: en denk ook eens aan het volgende . . . 
 
 Vermijd drukke achtergronden die de tekst in de voorgrond moeilijk leesbaar maken... 
 Pas de achtergrondkleur aan het achtergrondpatroon aan.  Dat voorkomt een schokeffect bij het 

inlezen van de pagina. 
 Vermijd webpagina's die louter uit schermvullende plug-ins bestaan zonder een alternatieve 

HTML-versie aan te bieden voor de gebruiker die de plug-in niet bezit. 
 Maak van achtergrondmuziek altijd een optie; ongewenste geluiden zijn vaak een doorn in het oor 

van de surfer. 
 Zorg voor leesbare tekstgroottes en varieer niet te veel met allerlei verschillende lettertypen en -

groottes op dezelfde pagina. 
 Wees terughoudend met teksten in kapitalen. Dat leest ongemakkelijk en associeert al gauw met 

'schreeuwen'. 
 Maak van je site geen brochureware; probeer het hergebruiken van bestaande informatie te 

vermijden.  Het Web is een interactief medium en vereist dus een andere aanpak. 
 Wees voorzichtig met acties die de gebruiker niet verwacht.  Het plots laden van een applet, 

onaangekondigde pop-up vensters wordt bijna nooit positief opgevat. 
 Flash-animaties (splash-page) zijn cool en vormen vaak de doorgang naar de eigelijke site. Bied 

echter alternatieven voor ongeduldige en unplugged gebruikers. 
 Controleer je site regelmatig.  Pagina's die niet meer gevonden kunnen worden en java(script)-

foutmeldingen werken op de zenuwen van de gebruiker. 
 Pas de venstergrootte aan de schermgrootte van de gebruikers aan.   

Maak pagina's niet te breed en vermijd extreem lange pagina's.  Scrollen is niet ieders favoriete 
tijdverdrijf. 

 Maak heldere en duidelijke pagina's waarin de belangrijkste informatie en benodigde links 
duidelijk herkenbaar en vindbaar zijn. 

 Zorg voor vernieuwing en updates! 
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Een interview 
 
'Web-design is zo veel meer dan alleen bruikbaarheid' 
 
Door Frith Breitzer  
 
Valerie Casey, 28, is Creative Director bij Frog Design. Zij heeft de leiding over het opbouwen van het 
digitale team op de bedrijfskantoren van de firma. Als docent aan de San Francisco State University, 
CCAC, UC-Berkeley en bij het San Francisco Mayor's Youth Employment and Education Program 
heeft zij haar studenten in het vak web-design voorgehouden dat zij web-design moeten zien als iets 
dat meer is dan gebruikers onmiddellijk wijzen waar zij moeten klikken. Adobe vroeg haar wat volgens 
haar de volmaakte opleiding webdesign is en wat webdesign tot goed webdesign maakt.  
 
Jij hebt een achtergrond in de film en de fotografie. Hoe ben je in web-design terecht 
gekomen? 
Ik zie design en communicatie als een geheel; het gaat om het vinden van oplossingen voor 
verschillende problemen, met welk medium je ook gaat werken, of het nu een computer is, fotografie 
of een combinatie van media.  
 
Ik heb mijn filmen en fotograferen gefinancierd door te werken in de milieu-industrie. Ik begon te 
beseffen dat wanneer we opnamen maakten of informatie presenteerden wij ons doel voorbijschoten 
wanneer we het niet op een bepaalde manier presenteerden. En ik besefte dat er een complete, 
visuele taal was waartoe ik me intuïtief voelde aangetrokken - dingen ruimtelijk rangschikken en 
spelen met diepte. Ik begon wat lessen te volgen in het multimedia-studieprogramma op de San 
Francisco State University. Dat was 1995. Het was een interessante tijd omdat niemand iets wilde 
doen met het Web omdat het allemaal toch maar werd weggegooid en omdat er zoveel beperkingen 
waren. Alles was zo grof en lelijk en het zou nooit ontworpen gaan worden.  
 
Denk je dat web-designers profijt hebben van een formele achtergrond in design? 
In de begintijd van het web, was je een ontwerper als je een tool kon gebruiken. Nu zoekt men naar 
vaardigheden in UI (user interface) en design. Persoonlijk, als creative director bij Frog, let ik vooral 
op de getuigschriften, en dat is wel een beetje ironisch omdat ik die zelf niet zo heb.  
 
Laat me eens denken hoe ik dat moet zeggen zonder dat ik er later erg boos over ben dat ik het heb 
gezegd: eigenlijk is wat ik probeer te zeggen dat ik een hekel heb aan exclusiviteit. Ik denk dat als 
iemand een idee heeft, en hij of zij wil dat idee overbrengen, ik hem of haar zou aanmoedigen. Ik zou 
er geen energie insteken om te zeggen dat er grenzen zijn en obstakels die eerst moeten worden 
overwonnen. Wanneer je tien minuten met iemand praat weet je al of die persoon iets te zeggen 
heeft, en of hij of zij de energie heeft die hem of haar moet motiveren te leren wat nodig is.  
 
Dus wie komt er bij jou op design-les? 
Iedereen die bij ons komt heeft weer een heel andere achtergrond: er zijn accountants en filmmakers 
en schrijvers en er zijn mensen die van school komen (als ontwerpers). Dat is wat deze sector sterk 
maakt - die diversiteit. Ik geloof niet in de waarheid van één enkele ontwerpstijl. Wij volgen hierbij niet 
een bepaalde routekaart en er is niet een groep mensen die ons is voorgegaan. Ik denk dat we meer 
vooruit moeten denken en mensen moeten binnenhalen die hier binnenkomen en die overlopen van 
ideeën.  
 
Vind jij dat er bepaalde vaardigheden zijn die ontwerpers moeten hebben of dat er ideeën zijn 
waar zij aan moeten worden blootgesteld? 
Als ik nu stond te praten tegen achttien-jarigen die digitaal ontwerper wilden worden, zou ik ze 
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aanmoedigen naar de universiteit te gaan en alleen maar te leren, colleges te volgen in de klassieke 
talen en de natuurwetenschappen en wat ook, een alfa-achtergrond krijgen - omdat dat je blikveld 
verruimt zodat je beter in staat bent oplossingen te vinden.  
 
Maar ik vind dat je kunt zien dat er een bepaalde discipline is in het werk van mensen die een design-
achtergrond hebben, die je niet ziet bij mensen die die achtergrond niet hebben. En wanneer ik zeg 
design-achtergrond, doet het er niet toe of dat betekent of zij een diploma hebben behaald aan een 
kunstacademie of dat zij het zichzelf hebben geleerd. Maar het is beslist zo dat je het verschil kunt 
zien bij mensen die typografie hebben gestudeerd, die de diplomatie van de rasterstructuur hebben 
bestudeerd en die weten hoe zij een concept moeten bedenken, en pas als zij dat gedaan hebben 
aan een computer gaan zitten en afbeeldingen en letters beginnen te ontwerpen.  
 
Hoe onderwijs je je studenten over bruikbaarheid? 
Ik breng naar voren dat op iedere pagina de gebruiker moet weten waar hij is, wat hij daar kan doen 
en waar hij heen kan en ik laat een werkelijk heel uiteenlopende reeks werk zien. Ik leer studenten 
contekst te leveren in plaats van dat zij expliciet instructies in hun ontwerpen opnemen.  
De huidige praktijk is over-gerationaliseerd en richt zich te veel op taakanalyse en niet genoeg op het 
inleven. Ik vind dat nu web-design werkelijk een ander punt heeft bereikt. Ik denk dat bruikbaarheid 
een actueel onderwerp was, en dat vervaagt omdat mensen gewend raken aan computers. Nu gaat 
opeens de aandacht niet meer uit naar "wij voldoen niet aan de bruikbaarheidsnorm". Nu is het "wat 
voor een te gekke ervaring kunnen wij gebruikers bereiden met beweging erin waarmee zij interactief 
aan de slag kunnen?" 
 
Dus is er geen plaats voor de Jakob Nielsens* van deze wereld? 
Ik denk dat bruikbaarheid dood is. Dat is werkelijk een extreme uitspraak, maar ik denk niet dat mijn 
gebruikers dom zijn. Zelfs de meest beginnende gebruiker heeft een soort van bewustzijn van de 
manier waarop een computer werkt, al is het maar van het kijken naar televisie. Dezelfde soorten 
stijlen worden door beide gebruikt, dus wij hebben nu een soort visuele taal die een brug slaat en de 
mensen raken eraan gewend.  
 
Het is geen verdienste wanneer men zich geheel en al richt op bruikbaarheid. Design moet meer zijn. 
Er bestaat een mythologie rond informatie-design. In de web-industrie zijn er mensen die zichzelf tot 
"experts" hebben uitgeroepen die uiteindelijk niets anders doen dan design-conventies versterken. 
Sommige van die conventions worden beperkende en contra-productieve uitspraken en daar naar 
handelen leidt niet noodzakelijkerwijs tot een optimale "digitale ervaring". Iedereen kan informatie-
designer zijn als hij of zij de tijd heeft- de tijd om te denken, plannen, zich in te leven en iets uit te 
voeren op basis van de actuele uitdaging, niet op basis van een vantevoren vastgestelde lijst van 
bruikbaarheidsregels.  
 
*Jacob Nielsen – http://www.useit.com – Usability Goeroe 
 
Maar je moet toch wel wàt aandacht besteden aan bruikbaarheid? 
Ja, dat ben ik met je eens. De sterkste blijft in leven. Als een site zo verwarrend is dat mensen hem 
niet kunnen gebruiken, dan verdwijnt hij. Men komt er niet meer terug. Maar ik ben heel voorzichtig, ik 
zal geen normen creëren waaraan iedereen moet voldoen. Je weet wel dat je wel eens in een 
tijdschrift pagina 86 probeert op te slaan, maar dat je die niet kunt vinden omdat het een advertentie 
met veel zwart is? Je neemt dat het tijdschrift niet kwalijk. Je merkt dat gewoon op. Dus waarom 
hebben mensen niet hetzelfde geduld met het Web? Het is gratis en vol rijk uitgevoerd, interessant 
materiaal.  
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Maar ik heb nooit het gevoel dat ik de weg kwijt ben in een tijdschrift, dat ik niet kan vinden 
wat ik zoek. 
Op het Web vraagt je je af hoe diep het is, hoe ver het gaat. Maar het is een ander medium.  
 
Toch is het wel heel wat te verklaren dat bruikbaarheid dood is. 
Betekent dit het einde van mijn carrière? Wat ik bedoel is dat wij ervaringen willen ontwerpen, en 
ervaringen hebben drie componenten: informatie-ontwerp, interactie-ontwerp en visueel ontwerp.  
 
Ik denk dat in het verleden het Web zo zwaar is gekritiseerd op het punt van download-tijd en dat al 
die dingen waar mensen als Jakob Nielsen over praten, hebben geleid tot een standaardisatie van de 
manier waarop web-pagina's worden gemaakt. Maar ik ben van mening dat waar het bij Internet 
werkelijk om gaat, is dat het volledig onafhankelijk is, het is volledig democratisch, het is volledig 
open.  
 
Ik word prikkelbaar bij de gedachte dat mensen die bruikbaarheid voorstaan omdat ze van mening 
zijn dat mensen dan toegang hebben tot informatie. Maar eigenlijk versperren zij de toegang omdat zij 
een model opstellen [waarin sommig materiaal past en waarin ander materiaal onmogelijk past]. In 
zekere zin, vind ik, censureert de bruikbaarheidsbeweging op het Web oorspronkelijk materiaal. Het is 
duidelijk dat, als gebruikers niet kunnen vinden wat zij zoeken, het toch allemaal geen zin heeft. Maar 
er zijn mensen met extreme opvattingen en ik zeg dat de tijd van die mensen voorbij is.  
 
Enkele van de beste sites verbreken Nielsens taboes - zoals te veel grafische afbeeldingen of 
een interface die niet duidelijk is. 
Ik heb een muismat [van een designer] gezien waarop stond "What would Jakob do? 
Ik denk dat we gebruikers meer krediet moeten geven. Ik denk dat mensen beter begrijpen wat de 
bedoeling is dan veel informatie-designers denken. Ik denk dat informatie-designers die een sterk 
visueel inzicht hebben, gewoonlijk meer succes hebben dan de designers die het zuiver zien als een 
architectuur-technisch software-probleem.  
 
Wanneer we eenmaal minder nadruk leggen op bruikbaarheid zoals het op dit moment wordt 
opgevat, wat maakt design dan goed of slecht? 
Het is volkomen subjectief. Ik ben geneigd meer te houden van werk dat meer fotografisch is, dat 
brutaler is en anders, dat eigenlijk kwetsbaar is en niet gebruik maakt van de omgekeerde "L"-
structuur.  
 
Ik denk dat de gemakkelijkste manier om te het verschil te zien tussen een beginnend ontwerper en 
een meer ervaren ontwerper hun behandeling van typografie is. [En er zijn nog andere dingen als] het 
formaat scherm waarvoor zij hebben ontworpen en of het in het venster van mijn browser past. Dat 
heeft te maken met bruikbaarheid, en dat zijn de dingen die mij het meest kunnen tegenstaan.  
 
Ik ben dol op sommige dingen die zijn gemaakt met Flash en DHTML. Sommige dingen hebben een 
geweldige filmachtige kwaliteit. Er is zo veel audio op het Web de laatste tijd, en ik vind dat werkelijk 
heel goed. Sommige van die sites zijn bijna een diepe ervaring. Ik vind Typospace : 
http://www.typospace.com/ goed [Thomas Noller] is met deze community voor DHTML- en Flash-
mensen begonnen om code en ideeën uit te wisselen.  
 
Ik word ook voor een deel aangetrokken door van die werkelijk slechte sites, zoals Sharon Stone's 
Scar, http://www.sharonstonesscar.com en er is Le Théâtre du Bâton Figure, 
http://www.announce.com/khein/michael/theatre gecreëerd door mensen die geen gevoel voor design 
hebben, maar iets hebben dat zij willen overbrengen. Je kunt IBM.com intypen of je kunt hun URL 
intypen; Eigenlijk kost het evenveel moeite en je komt bij wat zij hebben gepubliceerd. Het is een 
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ziener - iemand die zo iets op het Web plaatst en er tijd aan besteedt. Ook al is het verschikkelijk, zij 
doen er alles voor. Het heeft meer soul dan veel van de web-pagina's van bedrijven.  
 
Op jouw site heb je het over het samensmelten van het intellectuele en het emotionele in 
digitale media. Hoe benader je de emotionele aspecten van iets als een bedrijfs-site, die men 
gewoonlijk niet zou associëren met emotie? 
Het hangt ervan af hoe je emotie definieert. Wanneer ik aan een bedrijfs-site werk, zou het 
emotionele gedeelte kunnen zijn dat [bezoekers] een heel positieve ervaring hebben en dat kan 
worden bepaald door hoe snel zij de informatie kunnen vinden en hoe betrouwbaar de informatie is. 
Voor andere sites zou het kunnen zijn het spelen met andere dingen die je kunt doen met browser-
vensters met Flash en DHTML. Zelfs een JavaScript-rollover kan je een klein beetje een blij gevoel 
geven.  
 
Er is emotie in verschillende gradaties. En het intellectuele gedeelte komt naar voren wanneer je iets 
maakt dat een slim ontwerp is, dat een selectief design is - je gooit niet alleen maar wat informatie op. 
Men moet in een wereld kunnen stappen en even kunnen pauzeren.  
 
dit interview verscheen op de site van adobe.com jan 2001 
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3 - Webdesign basis begrippen 
 
Html  
HTML staat voor HyperText Markup Language. Webpagina's maken is niets anders dan tekst 
voorzien van de juiste codes (tags). Als je in een eenvoudige tekstprogramma als het kladblok, een 
‘on-opgemaakte’ of 'platte' tekst voorziet van de juiste codes en opslaat als een .htm bestand dan heb 
je van een tekstbestand een webpagina gemaakt. 
 
Hypertext  
Text gelinkt aan andere pagina's op het WWW door middel van een hyperlink. Vaak is deze tekst te 
herkennen doordat het onderstreept is in combinatie met een andere tekst-kleur . 
 
Hyperlink  
Een hyperlink koppelt een pagina op het WWW aan een andere pagina door naar een een specifieke 
lokatie op het internet te verwijzen.  
 
URL  
Iedere site, elke pagina heeft op het internet een uniek adres : de url oftewel Uniform Resource 
Locator. Een url bestaat uit het protocol, en een webadres en een 'pad'. 
 
Protocol  
HTTP staat voor HyperTextTransferProtocol, en is een vaste afspraak die beschrijft hoe de hypertext 
(html bestanden) over het internet getransporteerd moet worden.  
 
Andere protocollen zijn: 
- ftp:// - een file transfer protocol; een protocol om complete map-structuren met bestanden in een 

keer te kopieren naar een webserver. 
- file:// - een lokaal protocol 
- mailto:  - een e-mail protocol  
- https://: - een versleuteld (lees beveiligd) http protocol 
 
Serveradres en pad  
Iedere site heeft zoals gezegd op het internet een uniek adres bestaande uit het protocol, een 
serveradres, een pad en een bestand 
Als je  www.beeldfabriek.org typt dan is het exacte adres  http://www.beeldfabriek.org/index.html 
Waarbij http://  het protocol is,  www. beeldfabriek.org is het serveradres, en /index.html is het pad.  
Nu is het zo dat je index.html niet hoeft in te typen omdat de browser automatisch gaat zoeken naar 
een index.htm of index.html bestand op de webserver. 
 
Browsers  
De programma's waarin een webpagina bekeken wordt. De browser die gebruikt wordt om de html-
pagina te bekijken bepaalt ook hoe de pagina er precies uitziet. In een html-editor wordt de pagina 
opgemaakt, maar de exacte weergave is mede afhankelijk van de browser (internet explorer of 
netscape of firefox), de browser versie  en de browserinstellingen.  
 
Gebruik je browser(s) altijd als referentie naast je editor, om  met enige regelmaat het uiterlijk en de 
werking van je pagina's te checken. 
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Broncode (source)  
Als je in je browser met je rechtermuisknop op een webpagina klikt, dan kun je in het menu de 
bron(code) of source(code) van de pagina bekijken Met behulp van een eenvoudig tekst-programma 
kun je de html - code van de in de browser zichtbare pagina's bekijken. Als je je dus afvraagt hoe een 
pagina technisch in elkaar zit, kun je dat bekijken in de bron.  
 
Het veelvuldig bekijken en analyseren van web-pagina broncodes is de beste manier om je de 
werking en mogelijkheden van de html en webdesign eigen te maken. 
 
 
Editors  
Dit zijn programma's waarmee je je internet pagina's kan opmaken.  
Dat kan een eenvoudig tekstprogramma als kladblok zijn. Als je in kladblok  tekst voorziet van de 
juiste html-codes en je slaat het bestand op met de extensie .htm of een .html dan is het voor iedere 
browser leesbaar. Ook met een tekstverwerkings programma als word kun je tegenwoordig 
bestanden opslaan als webpagina. 
 
Programma's als frontpage en dreamweaver maken gebruik van een zg. WYSIWYG-interface, "what 
you see is what you get", je kan in deze programma's documenten vormgeven, de lay-out bepalen, 
fonts en kleuren instellen, afbeeldingen plaatsen en het programma genereert de daarbij horende 
html-codes. 
 
 
 
Nog even doorsurfen op de wikipedia . . .  
http://en.wikipedia.org/wiki/Url 
http://nl.wikipedia.org/wiki/Webpagina 
http://nl.wikipedia.org/wiki/Webdesign 
http://nl.wikipedia.org/wiki/Http 
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4 - Meer over Html 
 
Een opmaaktaal ( mark-up language) 
Feitelijk zijn HTML-bestanden tekst documenten waaraan opmaaklabels : de zg. 'tags' zijn 
toegevoegd.  
De wijze waarop tekst voor een website kan worden vormgegeven verschilt dan ook aanmerkelijk met 
de werkwijze voor opmaakprogramma's als quarkexpress of indesign.   
Enters, centreren, meerdere spaties, regel-eindes en het afbreken van woorden, kortom de hele 
layout moet mbv. <TAGS> in het document worden omschreven.  
 
Opmaaklabels en tags 
De tags worden niet worden weergegeven in de webbrowser-pagina.  
Om een onderscheid te maken tussen de 'tekst' en de codes staan alle opmaakcodes tussen een 
'kleiner dan' < en een 'groter dan' teken >.  
Het maakt ook niet uit of de tags <in kleine letters> of <IN HOOFDLETTERS> in het html document 
staan.  
 
Elk onderdeel van een webpagina wordt dus door middel van en tags gedefinieerd. Alles tussen de 
tags wordt door de browser weergegeven volgens de specificatie van de tag. < BEGIN-TAG > inhoud 
< /EIND-TAG > De inhoud van de tags bepaalt onder meer of een woord vet of cursief wordt 
weergegeven.  
  
Deze techniek wordt overigens al jaren in diverse zetsystemen toegepast en ook in een  
tekstverwerker als WordPerfect zat al iets dergelijks ingebouwd.  QuarkXPress werkt ook met 
'opmaaklabels' waardoor kopij al in een tekstverwerker 'voorgecodeerd' kan worden. 
  
Open en gesloten tags  
In het geval van de gesloten tag, staat de inhoud tussen twee tags, de begin-tag en de eind-tag. Bv 
de titel van een web-pagina. <TITLE>titel die in bovenin de browser verschijnt< /TITLE>  
 
HTML-tags worden meestal paarsgewijs  toegepast, de zg. gesloten tag.   
Een tag om de instructie 'aan' te zetten en een tweede om de tag weer ongedaan te maken.  Deze 
laatste tag is te herkennen aan het  /  teken (slash) dat direct na de eerste chevron gezet wordt.   
 
Een voorbeeld ter verduidelijking 
Stel we willen een stukje tekst vet weergeven, dan moet men dit in HTM L als volgt coderen:  
<B>tekst</B>.  
De eerste tag <B> geeft aan dat alle tekst in de stijl 'Bold', dat is Engels voor 'Vet', zal worden 
weergegeven.  De tweede tag </B> heft de stijl weer op.   
De tekst die achter de tweede tag geplaatst wordt, zal weer als normaal (lees ongeformatteerd) 
worden afgebeeld.  Als de tweede, afsluitende tag echter ontbreekt, dan zal verder alle tekst die op 
de pagina staat, in deze stijl worden afgebeeld.   
 
Bij de open tag is er sprake van maar een begin-tag, ze hebben geen 'inhoud' en geen eind-tag. Deze 
. Bv. de <BR> tag , door deze tag ergens in een regel te zetten breekt de regel af en begint er een 
volgende regel. Een open tag bestaat dus niet uit een paar tags maar uit een tag.  
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Nesting  
Als je een stuk tekst wil voorzien van meer dan een tag dan moet je dat stuk tekst 'nesten'. 
Hierondervolgt een voorbeeld:  
 
1. <B> vetgedrukt </B>    hier wordt de tekst vetgedrukt  
2. <I><B>vetgedrukt en cursief </B></I>  deze text wordt cursief en vetgedrukt 
 
Let goed op: dus niet <I><B> inhoud </I></B> maar: <I><B> inhoud </B></I> 
 
Bij het opmaken van een pagina moet er secuur worden gewerkt, want anders wordt het opsporen 
van het foutieve of ontbrekende opmaaklabel een flink karwei.  
Gecompliceerde HTML-pagina's, waarin bijvoorbeeld lijsten en tabellen toegepast zijn, zullen toch 
flink wat zoekwerk opleveren.  De schier eindeloze hoeveelheid tags die een tabel vereist, zorgen er 
al snel voor dat het overzicht verloren gaat.  En een verkeerd uitgevoerde correctie kan flinke 
gevolgen hebben.   
 
Het is altijd handig om op cruciale plaatsen commentaar  
<!-- dit wordt niet gelezen door de browser --> te geven bij de opmaak van de pagina. <!-- je kunt 
zo ook de groeten doen aan nieuwsgierige webdesigners--> 
 
 
Attributes 
Attributes zijn toevoegingen aan een tag waarmee de mogelijkheden van de tag worden uitgebreid. 
Zo kun je aan de <BODY> tag het attribute voor de achtergrond kleur van een web-paginatoevoegen, 
bijvoorbeeld BGCOLOR="RED".  
De body tag ziet er dan als volgt uit: <BODY BGCOLOR="RED"> en de achtergrond-kleur van de 
pagina is dan rood.  
Er kunnen meerdere attributes in een tag geplaatst worden maar er moet wel op gelet worden dat er 
altijd een spatie tussen de verschillende onderdelen van de tag zit.   
 
Hyperlinks en ankers 
De ankers <A> zijn uniek voor de HTML-taal en vormen de basis van de 'hypertekst'-mogelijkheden 
van het world wide web. Hierdoor volstaat het om met je muis een stuk tekst of een afbeelding aan te 
klikken, waardoor de computer opdracht krijgt om een ander HTML-document (per modem) op te 
halen.   
 
Deze techniek is niet alleen voorbehouden aan het World Wide Web; ook CD-ROM maken gebruik 
van hyperlinks.  Deze methodiek is overigens in 1945 al door ene Vannevar Bush besproken en later 
door Alan Kay en consorten in Xerox Parc laboratorium uitgewerkt. 
 
Als een tekst of een tekening 'aangeeft' dat er op een andere pagina meer informatie te vinden is, kan 
de gebruiker hierop 'klikken' en de desbetreffende pagina of bestand wordt via je modem downgeload 
en in je browser zichtbaar.  
 
Bij een ‘roll’ over een hyperlink wordt het adres waarnaar de link verwijst zichtbaar onderin het 
browservenster (status-balk). Een hyperlink moet uiteraard wel in de HTML-code worden ingegeven.  
Hiervoor wordt gebruik gemaakt van de anker-tag.  Deze is te herkennen aan het voorvoegsel 
<A></A>.  Het attribute 'HREF' wordt achter de <A> geplaatst om aan te geven dat het een hyperlink 
betreft. Met behulp van het 'HREF' attribuut kan een dus een verwijzing naar een andere pagina of 
zelfs een andere server gemaakt worden.   
 
Absolute en relatieve links 
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Met de waarde van het HREF attribute kan een absolute link (naar een webadres) worden gemaakt; 
of kan je een pad definieren naar een andere pagina binnen eigen website: een z.g. relatieve link. 
 
In de onderstaande code linkt de tekst 'deze link gaat naar de Beeldfabriek'  naar de website van de 
BeeldFabriek  - een absolute link. 
 

<A HREF="http://www.beeldfabriek.org/index.html">deze link gaat naar de Beeldfabriek</A> 
 
In de onderstaande code linkt de tekst 'Het laatste nieuws ' naar een 'nieuws.html' pagina in de folder 
'nieuws'  - een relatieve link. 
 

<A HREF="nieuws/nieuws.html">Het laatste nieuws</A> 
 
 
Het raamwerk  
De basis van elke web-pagina bestaat altijd uit hetzelfde stramien waarbinnen je je de pagina inhoud 
moet plaatsen. 
 
<html>   
<head>  
<titel>de titel van de pagina</title>  
</head>   
<body>  
 . . . . inhoud van de site : tekst, verwijzingen naar afbeeldingen, hyperlinks  
</body>   
</html>   
 
<html>…..</html>   -  de 'declaratie' van het html document 
<head>…</head>   - in de head staan titel, meta-informatie, scripts, commentaren.. 
<body>….</body> - de body bevat de zichtbare inhoud van de site : text, verwijzingen naar 
    afbeeldingen, hyperlinks;  de 'content'   
 
 
 
 
 
 
Afbeeldingen 
Er kan naast tekst ook beeldmateriaal aan je pagina worden toegevoegd. 
Foto's, tekeningen, animaties, geluid , video, applets etc… 
 
Aangezien een HTML-editor slechts tekst ( html) genereert zul je het benodigde beeldmateriaal van te 
voren moeten vervaardigen om aan je web-pagina toe te kunnen voegen.  
Hiertoe staat er een breed scala aan beeldbewerkingsprogramma's tot je beschikking, varierend van 
software pakketten die je bij je scanner krijgt tot professionele programma's als Photoshop. 
In een beeldbewerkingsprogramma kun je de afbeeldingen verkleinen of vergroten tot het benodigde 
beeldformaat (in pixels) en bewaren (saven) in een voor browsers leesbaar bestandsformaat.  
 
Dit zijn voor foto's, grafisch werk en animaties  .jpg en .gif . Dit zijn de bestands-formaten die een 
standaard browser, zonder extra plugins, altijd kan laten zien.  
Afbeeldingen worden met een <IMG> tag in de HTML-code gezet, met in die <IMG> het attribute 
SRC="bestandsnaam" (SRC=source). Dus <IMG SRC="foto.jpg"> is een tag die verwijst naar een 
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plaaje dat foto.jpg heet. De afbeelding staat echter niet in het document, de <IMG SRC=""> tag 
verwijst naar een plek op het WWW waar de afbeelding staat. 
 
De afbeelding kan ook heel ergens anders op het net staan, in dat geval moet tussen de " " van de 
SRC ook het complete pad (relatief) of de URL (absoluut) zijn aangegeven waar het attribute naar 
verwijst. 
 

Let op : Een  html document bestaat slechts uit tekst . . . er is dus geen beeld, geluid, 
animatie, video, etc . . in verwerkt maar er staan slechts verwijzingen naar deze elementen.  

 
 
Video, animatie en geluid 
Naast jpg- en gif-afbeeldingen is er nog een heel breed scala aan verschillende media-formaten in je 
pagina te 'bouwen'. Het nadeel hierbij is dat je voor het gros (Flashanimaties, Windowsmedia, 
Quicktime, etc.) van deze bestanden een plugin (een extra stukje software) op je computer moet 
installeren om ze  te kunnen bekijken. 
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5 - Een aantal tags om mee te beginnen 
 
 tags functies 

Structuur  

<HTML> 
<HEAD> 
<TITLE> titel </TITLE>   
</HEAD> 
<BODY> 
...............hier komt de pagina-inhoud 
</BODY> 
</HTML>  

 

Indeling 
<BR> 
<P></P> 
<HR> 

Break. 
Paragraaf . 
Horizontale lijn. 

<BODY> 

<BODY>...</BODY>  
 
TEXT="SILVER"  
BGCOLOR="RED"  
BGCOLOR="#FF0000"  
BACKGROUND="bestand.gif"  
LINK="#00FF00"  
VLINK="#FF0000"  
ALINK="#0000FF" 

Body specificaties. 
 
Attribute : Tekstkleur zilvergrijs. 
Attribute : Achtergrond rood.  
Attribute : Achtergrond rood. Hex.  
Attribute : Achtergrondplaatje.  
Attribute : Link-kleur. Groen 
Attribute : 'Visited' Link-kleur. Rood 
Attribute : 'Active' Link-kleur. Blauw 

Opmaak * 

<B>...</B> 
<I>.....</I> 
<U>...</U>  
<S>...</S>  
<CENTER>...</CENTER>  
 
<H1>...</H1> 
<H6>...</H6> 

Vet. 
cursief. 
Onderstreept, geen hyperlink. 
Doorgestreept. 
Gecentreerd .  
 
Grootste kop. 
Kleinste kop. 

<FONT> * 
  

<FONT FACE="arial">...</FONT> 
 
FACE="arial" 
SIZE="3" 
COLOR="red" 

Tekst tag, lettertype is arial 
 
Attribute : lettertype 
Attribute : grootte (van 1 tot 7) 
Attribute : textkleur (rood ) 

Plaatjes 

<IMG SRC="bestand.gif"> 
 
SRC="bestand.gif" 
WIDTH="x"  
HEIGHT="x" 
ALT="omschrijving"  
BORDER="x" 

image : attribute = pad+source.gif 
 
Attribute : plaatje + pad 
Attribute : breedte in pixels. 
Attribute : Hoogte in pixels. 
Attribute : Alternative tekst  
Attribute : Omlijsting in pixels. 

Ankers <A HREF="http://www.beeldfabriek.org/">...</A> 
<A HREF="bestand.htm">...</A> 

 
Naar webserver.(absolute link) 
Naar bestand. (relatieve link) 

 
 
Tegenwoordig wordt voor het opmaken van tekst gebruik gemaakt van Stylesheets (css) en in veel 
mindere mate door de tekst van je document te voorzien van de bovengenoemde opmaak en Font-
tags . . .   
 
Meer over stylesheets: http://nl.wikipedia.org/wiki/Cascading_Style_Sheets 
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6 - De Dreamweaver werkomgeving 
 
In dit hoofdstuk bespreken we de belangrijkste onderdelen van de Dreamweaver werkomgeving . . . 
vensters, paletten, inspectors, voorkeursinstellingen (preferences) . . .  
 
Hieronder zie je de geopende werkomgeving van dreamweaver . . .  
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Document-venster  
Het grootste en belangrijkste venster is het Document-venster. Hier bouw je de webpagina visueel op.  
In het Document-venster zie je een voorvertoning van de webpagina, ongeveer zoals die eruit zal 
zien in de Browser. Het Document-venster 'gedraagt' zich ook een beetje als een browservenster.  Je 
kunt het venster groter en kleiner maken.  Alle 'wrapping' elementen zullen dan naar beneden 
schuiven om te passen in een smaller venster.  Net als in de browser.Niet alle animaties, buttons, 
geluiden ed.  werken in het document venster.  Om te zien hoe een pagina eruit ziet en werkt zul je 
de pagina altijd moeten bekijken in je browser. (previewen) 
 
Elementen van het document venster 
In de titelbalk van het Document-venster zie je  de titel van de webpagina en tussen haakjes de 
locatie van het document in de Site Root-map en de naam van het document. Er verschijnt een 
sterretje naast de naam van het document als er wijzigingen zijn aangebracht op de pagina en deze 
zijn nog niet bewaard. 
 
Onder in het Document-venster vind je de 'Status Bar'.  Selecteer Edit > Preferences > Status Bar 
om instellingen vast te leggen voor de Status Bar. Je kunt daar instellingen maken voor de grootte 
van het document in pixels (monitor-resoluties) en de verschillende modem-snelheden 
 
Rechts onderinvind je het 'Window Size' menu. Hier zie je het huidige formaat van het 
documentvenster en je kunt een formaat voor het documentvenster selecteren voor het werken met 
bepaalde beeldscherminstellingen. Ook wordt er de grootte van de webpagina in KiloBytes en de 
downloadtijd getoond.  De grootte van de webpagina is die van het html-document, alle afbeeldingen, 
Shockwave Flash-movies, plug-in content, audio en andere externe content in KiloBytes. 
 
Links in de Status Bar vind je de Tag Selector.  In dit gedeelte ziet je alle html-tags gerelateerd aan 
een selectie in het document venster.  De tag van het geselecteerde element wordt vet getoond.  Als 
je alles binnen een bepaalde tag wilt selecteren, kun je op de betreffende tag klikken in de Tag 
Selector. 
 
 
 
View > Toolbars > Document (aanvinken) 
Door deze optie aan te vinken krijg je de onderstaande gereedschappen in beeld. Met de 
gereedschappen op deze toolbar kun je met een muisklik wisselen tussen code (html) en design; klik 
daarvoor op de < > tekens. Je kunt in deze toolbar ook de titel van je webpagina wijzigen en je bent 
slechts een muisklik verwijdert van de preview. Klik voor een preview in je browser op het 
‘wereldbolletje’ 
 

 
 
 
Preview in Browser 
In Dreamweaver kun je op elk gewenst moment de pagina openen in een op je computer 
geïnstalleerde browser. Je hoeft het document niet eerst te bewaren.  
Selecteer File  > Preview in Browser > Internet explorer. (sneltoets = F12) of klik op het 
wereldbolletje. 
 
Via Edit  > Preferences > Browsers kun je definieren welke browsers beschikbaar zijn om je pagina 
in te previewen. 
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Paletten, inspectors en vensters 
Verder heb je de beschikking over een aantal paletten, inspectors en vensters die het mogelijk maken 
om objecten op de pagina te plaatsen, functies uit te voeren, eigenschappen van elementen vast te 
leggen, objecten te selecteren, etc. 
Sommige paletten, inspectors en vensters passen zich aan aan het op dat moment geselecteerde 
object.   
 
Alle paletten, inspectors en vensters zijn te openen door de betreffende optie te selecteren in het 
Window-menu. 
 
 Window > Site (F8) waarin je alle documenten en mappen van de website vindt (de structuur van 

de website).  In dit venster kun je ook de documenten van en naar de webserver kopiëren 
(publiceren / up-en downloaden).   
 

 Window > insert  (Ctrl + F2) In het ‘insert’ palet staan een groot aantal tabbladen waarmee je 
tussen verschillende ‘elementen’ in je pagina kunt plaatsen 
- Common: Hyperlinks, emaillink, ankers, tabellen, layers, images . . . 
- Tables: Insert a table . . . 
- Frames: Diverse spannende  layouts 
- Forms: Alle formulier elementen. 
- Characters: Onder meer het euro teken . . . 
- Head: Meta-tags, keywords & description . . . 
 

 Window > Property-inspector, waarin je instellingen kunt doen voor het op dat moment 
geselecteerde object. (Ctrl + F3) 
 

 Window > others > code-inspector waarin je de door Dreamweaver gegenereerde html-code 
kunt zien en wijzigen.  (F10).  
Het is overigens handiger om tussen code en design te wisselen mbv. de document-toolbar (View 
> Toolbars > Document ) 
 

 Window > others > frames In het Frames-palet kun je frames of framesets selecteren om 
vervolgens in combinatie met de property inspector, alle 'eigenschappen' van de frameset te 
definieren  (shift + F2) 

 Window > others > Layers Het Layers-palet, waarin je alle Layers op de pagina vindt.  Hier kun 
je Layers selecteren, een naam geven, onzichtbaar of zichtbaar maken, en de stapelvolgorde 
wijzigen. 
 

 Window > Styles Het Styles-palet, alwaar je Style Sheets kunt definiëren, toepassen en wijzigen. 
 Window > Behaviours De Behaviors-inspector, waarin je Actions en Events kunt koppelen aan 

html-objecten. 
 
De meeste vensters kun je door middel van ‘Klik-slepen’ samenvoegen of apart plaatsen.  Als je  een 
venster op een ander venster plaatst, worden beide vensters samengevoegd.  Bovenin verschijnen 
dan Tabs met daarin de namen van de paletten of inspectors. Klik op de Tab om het betreffende palet 
of de betreffende inspector te tonen. 
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Het Site-venster - de structuur van je site 
 
Ga naar Window > Site of klik op F8 en je Site-files komen in beeld. In het site palet zie je een op de 
windows-verkenner lijkende structuur van mappen en bestanden. 

 
Klik op het rood omcirkelde icoontje en zowel 
de ‘remote site’ als de ‘local files’ worden 
zichtbaar. 
 
 
 
 
 

 
 
 
 
 
 
 
 
Local betreft de site 
zoals die op je harde 
schijf staat, bij de 
BeeldFabriek of thuis ,  
 
De remote-site laat zien 
wat er bij je provider op 
de harde schijf staat. 
 
 
 
 
Meer over het Site-venster in hoofstuk 7: het definieren van een site en in hoofstuk 8: FTP’en met 
Dreamweaver  
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Property-inspector                                           
De Property-inspector geeft altijd de eigenschappen tekst weer van het-op-dat-moment geselecteerde 
object. Open het properties venster met: window > properties  of  Ctrl + F3. 
 
In het onderstaand voorbeeld is er een afbeelding geselecteerd met de bestandsnaam (Src) 
beeldmerk_klein_kleur.jpg met een grootte van 200 (W) x 187 (H) pixels  en  17 Kbyte.  
 

 
 
 
 
In het onderstaand voorbeeld is er een stuk tekst geselecteerd; je kunt dan mbv. de property 
inspector verschillende instellingen veranderen lettertype, kleur, grootte, inspringen, lijsten . . . 
 

 
 
De Property-inspector is een venster dat je voortdurend nodig hebt als je een webpagina aan het 
maken bent. 
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Code-inspector 
Om snel te wisselen tussen Code-view (html) en Design-view kun je het beste de document toolbar 
(zie pagina 19) gebruiken. Klik op de < > tekens voor de Code-view. 
Met windows > others > code-inspector of F 10. open je naast het document een extra palet met 
daarin de code. 
 
In de afbeelding hieronder zie je de Code-inspector waarin een tekst is geselecteerd. 
 

 
 
 Alle handelingen die je uitvoert in het Documentvenster en de paletten, worden onmiddellijk 

gereflecteerd door wijzigingen in de html-code in het html-venster. 
 Wijzigingen die je aanbrengt in het html-venster, worden gereflecteerd in het Documentvenster, 

zodra je het Document-venster actief maakt. 
 Bovendien worden alle selecties die je maakt in het Document-venster of in het html-venster, in 

het andere venster automatisch ook gemaakt. 
 
De afbeelding hieronder betreft  het Document-venster dat bij de afbeelding hiervoor hoort.   
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Beeld elementen  (tekst, afbeeldingen, filmpjes ed..) plaatsen 
Het document venster in Dreamweaver werkt als een zeer eenvoudig tekstverwerkings-programma: 
Text plaats je op je pagina door te typen.  
 
Om andere beeld-elementen op de webpagina te plaatsen, kun je onder het lnsert-menu het 
gewenste object te selecteren.  Het 'object' komt dan terecht op de plek waar op dat moment de  
cursor staat. Ook met het Objects-palet kun je elementen, anders dan tekst, toevoegen op de 
webpagina. Standaard kent Dreamweaver vier categorieën objecten: Common, Forms, Head en 
lnvisibies. Het aantal categorieën is door jezelf uit te breiden. 
 
Elementen  (tekst, afbeeldingen ed..) selecteren 
Als je  op een html-tag in de Tag Selector linksonder in het Document-venster klikt, dan selecteer je 
alles binnen deze tag in het Document-venster én in het html-venster.. 
 
In voorbeeld op de voorgaande pagina is dat alles wat er tussen de <body> </body> tags staat.  
 
In Dreamweaver kun je selecties maken in het document venster door  
 
 op de elementen te klikken,  
 met de muis over de elementen te slepen of  
 door de tag-selector te gebruiken. 

 
Je kunt ook de html-code selecteren in de Code-inspector. 
 
LET OP : Sommige objecten, zoals Frames, hebben een bijbehorend venster dat je kunt openen door 
onder het Window-menu de desbetreffende keuze te maken.    
Door te klikken op onderdelen in het Frames-palet kun je de eigenschappen van de betreffende 
onderdelen in de Property-inspector wijzigen. Voor meer informatie over frames zie hoofdstuk 9; 
Frames 
 
LET OP: Er zijn zogeheten Invisible-elements voor Layers, anchors, commentaar, Scripts en line 
breaks.  Deze zijn niet zichtbaar als je de pagina opent in een browser.   
Ga naar View  > Visual Aids > . . .  om hier je instellingen te maken 
Ze verschijnen als gele iconen in het Document-venster.  
 
In de Preferences van Dreamweaver kun je aangeven welke lnvisible-elements je in het 
Documentvenster te zien krijgt.  Selecteer Edit  > Preferences > lnvisible Elements. 
 
Contextuele menu’s (shortcut-menu) 
Contextuele-menu's zijn de pop-up menu's die verschijnen bij klikken met de rechtermuisknop. De 
keuzemogelijkheden in een shortcut-menu zijn afhankelijk van het op dat moment geselecteerde 
object. 
Je kunt overal, met je rechtermuisknop, binnen de dreamweaver-interface klikken voor meer info via 
het contextuele menu.  
 
Probeer jezelf aan te leren om met de shortcut-menu's te werken.  Dat kan je veel tijd besparen. 
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Werken in Dreamweaver 
In Dreamweaver kun je op twee manieren werken aan je webpagina. 
 
1. In het Document-venster met behulp van vensters, inspectors en paletten.  
2. In de HTML-inspector, waar je html-code kunt intypen, verwijderen, zoeken en wijzigen. 
 
Bovendien zijn er dus meerdere manieren om hetzelfde resultaat te bereiken: 
 
 Je kunt werken in de Code-inspector en hier de html-code typen.  
 Je kunt gebruikmaken van de keuzen uit de menubalk. 
 Je kunt werken met de vensters, paletten en inspectors.  
 Je kunt gebruik maken van de keyboard-shortcuts.   
 Of je kunt werken met de shortcut-menu's. 
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7 - Het definiëren van een website in Dreamweaver 
 
Als je van plan bent om met Dreamweaver een website te bouwen en te onderhouden, dan zul je 
eerst een website in Dreamweaver moeten definiëren. 
 
Als je Dreamweaver als editor gebruikt om een website te bouwen, dan is het noodzakelijk dat alle 
documenten die gebruikt worden in de website, zich in één map bevinden ; de Lokale Site Root-map. 
Dit stelt het programma Dreamweaver in staat om in de html code de juiste verwijzing (link) naar een 
afbeelding, html-document of andersoortig bestand te definiëren.  
 
Daarnaast kan het programma dreamweaver als je bestanden verplaatst binnen de Site-files ook 
automatisch de bestaande linken & verwijzingen ‘updaten’ 
 
De locatie en de naam van externe documenten  ( plaatjes, video, geluid ed. ) worden in de html-code 
in principe aangegeven met een document-relatieve link.   
Dat betekent dat de locatie van het html-document het uitgangspunt is en dat vanaf die locatie het 
'pad' naar het externe document in de html-code wordt beschreven. 
 
 
Lokale Site Root-map 
Het belangrijkste dat je moet aangeven als je een website definieert, is de Lokale Site Root-map.  Dat 
is de map die dient als root, als basis, van je website.  Als je in Dreamweaver pagina's gaat maken of 
bewerken, dan werk je met de documenten in deze map. 
 
Waar die map staat : op de harddisk, op een Zip drive,  of op een diskette is niet van belang.  
 
De mappenstructuur binnen de Lokale Site Root-map is wel van belang.  Dit is namelijk de 
mappenstructuur die straks ook zal worden aangemaakt op de 'echte' webserver. 
Omdat de structuur van de mappen en de documenten, die je op een lokale schijf aanmaakt en 
gebruikt als Lokale Site Root, identiek is aan de structuur van mappen en documenten zoals die op 
de 'echte' webserver wordt gegenereerd, zullen alle links die lokaal correct functioneren straks ook op 
de webserver in orde zijn. 
 
In Dreamweaver werk je altijd met de lokale documenten, nooit met de documenten die op de 
webserver staan. Als je een website hebt gemaakt en getest, dan plaats je de html-documenten met 
behulp van het FTP protocol op de webserver.  
 
Als je een website hebt gedefinieerd in Dreamweaver, kun je webpagina's gaan maken.   
 
De html-documenten bewaar je op een locatie in de Lokale Site Root-map. Alle gelinkte bestanden ( 
plaatjes, video, geluid ed. ) die je in je website gebruikt, moeten in de Lokale Site Root-map staan. 
Alleen dan kun je er zeker van zijn dat er geen gebroken links zullen zijn als je de website uiteindelijk 
op de webserver plaatst. 
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Benodigde informatie 
De homepage (index.html) moet altijd in de Site Root-map staan.  De homepage is de pagina die 
wordt geopend, als een gebruiker in de browser uw URL opvraagt zónder de naam van een html-
document. Bijvoorbeeld: http://www.beeldfabriek.org/ 
 
Afhankelijk van de webserver-software moet de homepage een bepaalde naam hebben.  
Voorbeelden zijn: index.htm, index.html, default.htm, home.htm. 
 
Het is beter om geen spaties te gebruiken in de namen van documenten.  
Gebruik ipv. spaties de _under_score  om de leesbaarheid te verhogen 
 
Bepaal de filenaam-extensie voor html-documenten.  .htm of .html Dit kun je opgeven in de 
Dreamweaver-preferences.  Selecteer Edit  > Preferences en kies voor de General-categorie. Elk 
document dat html-code bevat om een webpagina te beschrijven moet de juiste filenaam-extensie 
hebben, meestal is dit htm of html. 
 
Zorg ervoor dat de mappenstructuur helder is en dat de namen van mappen en documenten in de 
Lokale Site Root logisch en 'leesbaar' zijn.   
 
Deze structuur wordt bij het kopiëren van de documenten naar een lokatie op de webserver, ook wel 
het 'publishen' van de website genoemd, overgenomen op de webserver. 
Als je na het publishen van de website allerlei ingrijpende veranderingen gaat uitvoeren, dan zul je 
handmatig op de webserver mappen en documenten moeten gaan verwijderen en het is in dat geval 
erg prettig als je site helder van structuur is. 
 
De stappen voor het definiëren van een website 
 
1. Maak een nieuwe map aan op een lokale schijf , het is het eenvoudigst om deze map aan te 

maken op de harddisk van je computer, maar het kan ook op een file-server of een verwijderbaar 
opslagmedium als een diskette of ZIP drive.  

 
Bij de BeeldFabriek zul je zelf deze map aan moeten maken 
Klik op het bureaublad op het icoon : My Computer  ga dan naar :  
Piet op fabriek\home (Z:)  (de cursist heet piet in dit voorbeeld). 
In deze map kun je dan het beste een map aanmaken met de naam – website – 
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2. Open het programma Dreamweaver en selecteer Site  > New Site . . . en klik New 
 

 
 
3. Selecteer in het nu geopende Site Definition-venster het tabblad – Advanced – en je kan 

vervolgens alle gegevens betreffende de nieuwe website invoeren. 
 
Het ondestaande venster begint altijd bij ‘Local Info’; deze instellingen moet je eerst maken om in 
Dreamweaver, lokaal, te kunnen werken. Lees op de volgende pagina wat de mogelijkheden van de 
verschillende categorien zijn en hoe je je ‘Local Info’ goed instelt. 
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De linkerkolom van het Site Definition-venster bevat de volgende categorieën  
 
 Local Info: Hier definieer je alle gegevens die Dreamweaver nodig heeft voor de Lokale Site. 
 Remote Info: Hier definieer je alle gegevens die Dreamweaver nodig heeft om een verbinding te 

maken met de webserver en documenten naar en van de webserver te kopiëren.  
 Testing server: 
 Cloaking: Het uitsluiten van mappen en bestanden van ‘site-operations’ 
 De sign Notes: Het toevoegen van opmerkingen voor een verbeterde integratie met andere 

macromedia programma’s 
 Sitemap Layout: Hier definieer hier alle gegevens om een visuele weergave van de structuur van 

de website te kunnen genereren: het Site Map-overzicht. 
 File View Columns: 
 Contribute: Extra functionaliteit om met meerdere mensen aan een site te kunnen werken. 

 
Klik links op een categorie en in het rechtergedeelte van het venster kun je instellingen doen voor de 
betreffende categorie. 
 
 
Local Info instellingen 
Op de voorgaande pagina kun je zien hoe een website (lokaal) bij de BeeldFabriek goed gedefinieerd 
is. Volg de onderstaande stappen om dit voor je eigen website te doen. 
 
1. Geef de nieuwe website een naam (je eigen naam) door deze in te typen bij Site Name.  Deze 

naam wordt alleen binnen Dreamweaver gebruikt.  
 
2. Selecteer een Local Root Folder. Dit is de map ‘Website’ op ‘My computer’ 
 
3. Klik op het icoon van de map om de betreffende map te selecteren.  Blader naar :  

Daan op fabriek/home(Z:)  > Website  klik openen en klik dan op opslaan.  
 
Nu heb je je eigen map op de server de BeeldFabriek gedefinieerd als Root-folder. 

 
4. Default Images Folder (optioneel); dreamweaver kopieert bestanden (plaatjes ed.) die je 

importeert automatisch naar deze map. In dit voorbeeld is in de map ‘Website’ een map ‘ _ruw 
materiaal’ aangemaakt & geselecteerd. 

 
5. Type het adres van de webserver in het veld met het label HTTP Addres. Deze optie gebruik je 

als je met absolute links werkt in je website. 
 

6. Selecteer bij voorkeur de Use Cache to Speed Link Updates-optie. Als je deze optie selecteert, 
wordt een Cache-document aangemaakt met informatie over alle documenten en links in de 
Lokale Site. Met behulp van de informatie in het Cache-document kan Dreamweaver bepaalde 
site-, link- en management-taken sneller uitvoeren.   
  

 
Is alle informatie ingevoerd? klik dan achtereenvolgens OK en Create en nu kun je aan je website 
gaan werken. 
 
Je kan op deze wijze in dreamweaver aan meerdere websites aanmaken en onderhouden. Je kiest 
een specefieke website door de naam te selecteren in het pull-down menu van de site-files. (Window 
> Site of F8 ) 
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Werken met het sitevenster 
Selecteer Window  > Site of klik F8 
 

 
 
 
Snel werken met het sitevenster  
Open bestaande html-documenten door dubbel te klikken op het betreffende document in het local 
Folder-gedeelte van het Site-venster en nieuwe bestanden en mappen kun je toevoegen door met je 
rechtermuisknop in de lokal folder te klikken en New file  cq. New Folder te selecteren. 
 
 
LET OP als je een gedefinieerde site uit het Dreamweaver programma verwijdert,  blijven de 
bestanden op de harddisk gewoon staan. 
 
Als je in je sitefiles een bestand verwijdert is dit bestand van je harddisk verdwenen. 
 
 
Remote Info oftewel FTP instellingen 
Als je je website wilt gaan publiceren (uploaden) dan zul je ook een aantal instellingen onder het 
onderdeel ‘remote’ moeten maken. De instellingen die je daarvoor moet maken vind je in Hoofdstuk8: 
FTP’en met Dreamweaver. 

Boven in het Site-venster vind je een aantal 
knoppen.  Deze knoppen hebben allemaal te 
maken met het heen en weer kopiëren van 
documenten tussen de Lokale Site Root-
map en de webserver.  
 
Met behulp van de pull-down menu’s kun je 
switchen tussen websites & views (local / 
remote) 
 
Door op het rood-omcirkelde icoontje te klik-
ken open je de site-files met zowel Local- als 
Remotesite in beeld. (zie Hoofdstuk 8) 
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8 - FTP'en met dreamweaver 
 
FTP oftewel het File Transfer Protocol  
Dit protocol wordt gebruikt om bestanden & bestandsstructuren (mappen, bestanden & links) in een 
keer naar een andere computer te kopieren. Dit kan lokaal zijn (offline) maar ook online om bv. je 
versgebouwde site op het internet te publiceren ( lees kopieren naar een http oftewel webserver) 
Ftp'en doe je met een FTP programma WS_FTP LE , msFTP of Fetch (mac) maar ook met 
dreamweaver kun je FTP'en dit doe je door in je site definitie window naast de instellingen voor de 
root folder ook de instellingen voor de Webserver in te voeren. 
 
Ga naar Site > Edit Sites. . . , selecteer de ‘website’ die je wilt editen en klik op edit. 
 

 
 
 
Vervolgens opent zich het site definition window (zie afbeelding op de volgende pagina). Selecteer 
het Advanced tab-blad en klik vervolgens in het linker menu op Remote. Je kunt nu rechts bij het 
Server Access pull-down menu kiezen uit de volgende drie opties 
 
 None - selecteer deze optie als je de website alleen lokaal wilt gebruiken en niet wilt publishen op 

een webserver. 
 

 Local/Network - selecteer deze optie als de webserver benaderbaar is als netwerkdrive, of als de 
webserver-software draait op je eigen computer.  Geef de map aan waar de documenten van de 
website moeten worden opgeslagen.   
 

 FTP - selecteer deze optie als je met behulp van het FTP-protocol documenten wilt kopiëren naar 
en van je webserver (downloaden & uploaden danwel publiceren).  
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FTP instellingen 
 
Om te kunnen FTP’en hoef je maar drie dingen te weten: 
Het server-adres,  je inlognaam en je wachtwoord. 
 

 
 
 Typ het FTP-adres waar je de documenten van de website kunt downloaden en uploaden, in het 

veld met het label FTP Host. Je kan het voorvoegsel ftp:// bij het adres weglaten. 
 
Als je de documenten en mappen van voor je website in een subdirectory van de webserver wilt of 
moet plaatsen, type dan in het veld met het label Host Directory de naam van deze subdirectory / 
map.  

 
De map (Host Directory), die de root-level-documenten en mappen van de website bevat, wordt ook 
wel de Site Root genoemd. Je kan het veld Host Directory leeg laten, als je na inleggen met FTP 
automatisch komt in de map op de webserver die dienst doet als Site Root. De Site Root-map is 
vastgesteld door de systeembeheerder van de webserver. 
 
 Geef bij Login de gebruikersnaam op, die je gebruikt om met FTP in te loggen op de webserver.  

Dit moet de naam zijn van een gebruiker die de rechten heeft om documenten aan te maken en 
verwijderen.  

 Als je bij password je password hebt ingevuld, kun je er voor kiezen de optie save aan te vinken 
, dat houdt wel in dat iedereen met deze instelling op de webserver aan de slag kan gaan. 

 Als de webserver wordt beveiligd door een Firewall, activeer je de Use Firewall-optie. Als je deze 
optie selecteert, dan zul je nadere informatie moeten aangeven in de Dreamweaver Preferences.  
Selecteer Edit  > Preferences > Site. 
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FTP'en oftewel kopieren van bestanden naar de remote server. 
Heb je dejuiste FTP-instellingen gemaakt dan sluit je het definitieste dialoogvenster af, klik Done en 
ga naar je Site > SiteFiles  (F8) 
 

 
 

 
 

Klik op het rood-omcirkelde 
icoontje om tegelijkertijd local- 
en Remote View in beeld te 
krijgen. 

In dit voorbeeld zie je rechts de Local Folder en links de Remote Site (de 
harde schijf van de provider). Door simpelweg in de Local Folder een 
bestand of map te selecteren en op Put (de roodomcirkelde blauwe pijl) te 
drukken worden map & bestand gekopieerd naar de Remote Site en klaar 
is kees. 
 
Je kunt ook met de muis bestanden klikslepen naar de folder van je keuze 
 
En als je met je rechtermuisknop in de local folder cq. remote site klikt 
krijg je een popup menu met nog een groot aantal extra mogelijkheden. 
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10 - Tabellen & Dreamweaver 
 
De tabel is een essentieel onderdeel van een webpagina als het gaat om layout en positionering van 
beeldelementen. Met tabellen kun je de onderlinge positionering van tekst en afbeeldingen min of 
meer vastleggen. Min of meer en nog steeds vrij omslachtig maar met ruim voldoende mogelijkheden 
om een pagina op te kunnen maken 
 
 
Het maken van een tabel  
 
Open een nieuw document en selecteer lnsert > Table. 
 

 
 
Er verschijnt nu een dialoogvenster, waarin je de eigenschappen van de aan te maken tabel kunt 
opgeven. Klik OK en de tabel komt terecht op de plek waar de cursor staat. 
 
De tabel ziet er dan zo uit als in de afbeelding van de volgende pagina. 
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Een tabel bestaat uit rijen,  kolommen en cellen. 
 
In elke cel van een tabel kun je beeldelementen , tekst & plaatjes, plaatsen en bewerken zoals je dat 
in de body van een HTML pagina ook doet. 
 
In het voorbeeld hieronder zie je in het dreamweaver document een geselecteerde tabel die bestaat 
uit 3 rijen 4 kolommen  ( dus 12 cellen ). De breedte van de tabel is 75%. De 'border' is 1 pixel breed 
 

 
 
Manieren  om de hele tabel te selecteren :  
 
Zet de tekstcursor in een cel van de tabel en klik op de <table>-tag in de Tag Selector linksonder in 
het Document-venster. 
 
of 
 
Als je met de aanwijzer van de muis in de buurt van tabel komt, verandert de aanwijzer van de muis 
van vorm.Als de muis bij de randen van de tabel komt, verschijnt de aanwijzer van de muis als vier-
pijlenicoon , 'Klik' en selecteer de hele tabel. 
 
 
Heb je de tabel geselecteerd dan kun je de tabel met behulp van de property inspector inspector 
verder bewerken. 
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De tabel en de property inspector 
Als je eenmaal een tabel hebt gedefinieerd kun je met behulp van je document en de properties de 
eigenschappen van de tabel verder bepalen 
 
Vastleggen van breedte en hoogte van de tabel : 
 
 Selecteer % om de breedte en hoogte van de tabel een percentage te laten zijn van het 

browservenster. 
 Selecteer Pixels om de breedte en hoogte van de tabel 'vast' te zetten op een bepaald formaat. 

 
Instellingen in de Property-inspector voor de geselecteerde tabel  
 

 
 
 Table Id - hier kun je de tabel een naam geven. (id = identiteit) 
 Rows en Cols - hier zie en bepaal je hoeveel rijen en hoeveel kolommen de tabel heeft. 
  W en H - definieer hier de breedte en hoogte van de tabel; in procenten of in pixels. 
 CellSpace - de hoeveelheid ruimte tussen de cellen van de tabel.  In pixels. 
 CellPad- de hoeveelheid ruimte tussen de inhoud van de cel en de randen van de cel.  In pixels. 
 Align - met de opties uit het pop-upmenu kun je een tabel lijnen in het browservenster. 
 Border- geef hier de breedte van de rand om de tabel aan.  Als je de tabel alleen gebruikt voor de 

layout van de elementen in de cellen, geef de tabel dan een border van 0. 
 
 Clear Row Heights en Clear Column Widths-knoppen om alle instellingen voor de hoogte van 

rijen of de breedte van kolommen te verwijderen. 
 Bij de Bg-opties kun je een achtergrondafbeelding voor de tabel definiëren of de tabel een 

achtergrondkleur geven. 
 Light Brdr en Dark Brdr - hier kun je de rand om de tabel twee verschillende kleuren geven om 

een 3D-effect te bereiken.  De Light Brdr-kleur verschijnt langs de boven- en linkerzijde.  De Dark 
Brdr verschijnt langs de onder- en rechterzijde.  Verwijder de hexadecimale waarden uit de velden 
om weer de standaardinstellingen te gebruiken (grijs). Brdr - hier selecteer je de kleur voor de 
rand om de tabel. 

 
Als View > Visual Aids > Table Borders actief is en de ‘Border’ = 0, dan zul je in het Document-
venster de cellen zien met een stippellijn eromheen. 
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Selecteren van rijen kolommen en cellen 
Als je rijen, kolommen of cellen hebt geselecteerd, dan kun je in het onderste gedeelte van de 
Property-inspector de eigenschappen van het betreffende tabelelement instellen en in het bovenste 
gedeelte kun je in één keer instellingen voor tekstformattering doen. 
 
 Als je  links naast de tabel bij een rij komt, verschijnt de aanwijzer van de muis als een pijl naar 

rechts.  Eén enkele klik en je selecteert de betreffende rij. 
 Als je boven de tabel bij een kolom komt, verschijnt de aanwijzer van de muis als een pijl naar 

beneden.  Eén enkele klik en je selecteert de betreffende kolom. 
 Zet de cursor in een van de cellen en Shift-klik in meerdere cellen of klik & sleep over cellen.  Zo 

kun je meerdere aaneengesloten cellen selecteren.  Ctrl-klikop cellen om meerdere, niet-
aaneensluitende cellen te selecteren. 

 
In het bovenste gedeelte van de Property-inspector kun je de instellingen doen voor de elementen die 
in de cel zijn geselecteerd 
 

 
 
In het onderste gedeelte van de Property-inspector kun je de volgende instellingen doen voor de 
geselecteerde rijen, kolommen en cellen 
 
 Horz - hier kun je aangeven hoe de inhoud in de geselecteerde cellen horizontaal moet worden 

gelijnd in de cel.  Selecteer left, right of center.  
 Vert - hier kun je aangeven hoe de inhoud in de geselecteerde cellen verticaal moet worden 

gelijnd in de cel.  Selecteer top, middle, bottom, of baseline.  
 W en H - in deze velden kun je waarden in pixels opgeven die de breedte en hoogte van de 

geselecteerde cellen definiëren.   
 Bg - selecteer hier een achtergrondafbeelding voor de geselecteerde cellen. 
 Bg - selecteer een achtergrondkleur voor de geselecteerde cellen.  Deze kleur verschijnt alleen in 

de cel, niet in het CellSpace-gebied of de rand om de tabel. 
 Border - hier kunt u een kleur aangeven voor de randen om de geselecteerde cellen. 
 De Merge Selected Cells-knop kun je gebruiken om meerdere geselecteerde cellen samen te 

voegen tot één cel. 
 De Split Cell-knop kun je gebruiken om de geselecteerde cel op te splitsen in meerdere rijen of 

kolommen.  Als je deze functie gebruikt, verschijnt een dialoogvenster waarin je kunt aangeven 
wat er moet gebeuren. 

 No Wrap - als je deze optie activeert, zullen de cellen breder worden om alle inhoud in de cellen 
te laten passen.  Als je deze optie niet activeert, worden de cellen hoger om alle inhoud te laten 
passen.  
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Een document en de bijbehorende de broncode (tabel). 
Dit is de tabel van de voorgaande afbeeldingen maar nu is er in de cellen van de tabel met teksten 
gewerkt. 
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11 - Frames & Dreamweaver 
 
Met frames kun je een webpagina opdelen in verschillende velden. In elk veld kan een ander html -
document worden geopend.   
 
Die velden heten frames.Een veelgebruikte toepassing van frames is om de pagina op te delen in 
een navigatie (menu) gedeelte aan een zijde van het browservenster en een gedeelte waarin de 
pagina’s zichtbaar worden als je een van de menu-items aanklikt. 
 
Als  een webpagina is opgedeeld in frames, dan is het document waarin je deze frames bekijkt een 
zg. een frameset-document. In dit document zijn de frames gedefinieerd.   
 
In het framesetdocument staat de volgende informatie beschreven :  
 
1. het aantal frames ( rows=" " of cols=" " ) en de afmetingen 
2. welk html-document moet worden geopend in elk frame (src=" ") 
 

 
 
Optioneel : 
 namen van frames (dit is wel belangrijk ) 
 of er wel of geen frameborders te zien zijn  
 de kleur en dikte van die frameborders. 
 het aan/uitzetten van scrollbars 
 het wel/ of niet 'wrappen' van de inhoud. 

 
LET OP   
Een webpagina met twee frames, bestaat uit drie documenten: het html-document met 
de frameset en twee html-documenten: een voor elk frame. 



 48

Een frameset maken in dreamweaver 
Maak een nieuw document aan. File > New (Ctrl + N).  en selecteer ‘general’ & Frameset . Je krijgt 
dan het onderstaand dialoog venster. Selecteer vervolgens een pagina-indeling 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
. . . . vervolgens geef je de frames een 
naam en klik je op OK.  
 
Je kunt nu de inhoud van de 
afzonderlijke frames ( de html-
documenten ) gaan bewerken (tekst & 
afbeeldingen & tabellen & formulieren 
toevoegen) Elk frame van de frameset is 
een apart html-document en dus ook als 
zodanig te bewerken.   
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Opslaan 
 
Een webpagina met frames bestaat uit meerdere html-documenten. Om deze te bewaren, kun je als 
volgt te werk gaan : Kies File > Save All en je slaat achtereenvolgens de frameset en de twee frames 
op. In het onderstaand voorbeeld zie je dat de menupagina 'geselecteerd' is om op te slaan. 
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Frameset- en frame properties 
In een document met frames heb je te maken met frameset-properties en frame-properties.  Om in 
de Property-inspector eigenschappen van een frame of frameset aan te kunnen passen, zul je eerst 
het frame of de frameset moeten selecteren. 
 
Selecteer  Window > Others > Frames. (shift + F2) Dreamweaver opent het Frames-palet.  
(Advanced Layout) 
 
Als je in dreamweaver een frame(set) wil bewerken dan werk je tegelijkertijd met de property-
inspector en de frames-inspector. 
 
In de Frames-inspector zie je een schematische weergave van frameset(s) en frames.   
Framesets worden aangegeven door een wat dikkere rand en frames worden aangegeven door een 
dunne grijze rand.  Daarnaast zijn ook de namen van de frames zichtbaar in de frames-inspector.  
 
Het selecteren van een frameset of een frame is een kwestie van een muisklik. 
 
Frameset-properties 
 
 Klik op het kader van de betreffende frameset in de Frames-inspector om een frameset te 

selecteren.Als de frameset is geselecteerd wordt in de Frames-inspector  de rand om de 
geselecteerde frameset donkerder.  

 Nu kun je in de property inspector de eigenschappen van de frameset bewerken. 
 
In de onderstaande afbeelding is de Frameset geselecteerd in het Frames-tabblad 
 

 
 
Lees de toelichting op de volgende pagina voor de Frameset -properties
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Als je een frameset hebt geselecteerd, kun je in de Property-inspector de eigenschappen van de 
Frameset vastleggen : 
 
 Borders  Geef hier aan hoe de afscheidingen tussen de frames in deze frameset eruit moeten 

zien Selecteer Yes uit het pop-upmenu voor afscheidingsranden.  Selecteer No voor een lijn of 
Default om de browser te laten bepalen hoe de randen verschijnen.  De standaardkleur is steeds 
grijs  

 Border Width  Hier kun je aangeven hoe dik de afscheidingsranden tussen de frames moeten 
zijn.  

 Border Color Selecteer een kleur voor de afscheidingsranden.  
 RowCol Selection  Hier zie je een visuele weergave van de rijen en kolommen in de frameset.  

Door te klikken in deze 'preview' kun je een rij of een kolom selecteren.  Bij Value en Units kun je 
dan de hoogte van de rij of de breedte van de kolom opgeven. 

 Value  Hier kun je de breedte of hoogte van het frame (Column of Row) opgeven.  
 Units  De maateenheid van Value.  Je kan kiezen voor Pixels, Percent of Relative.  De 

beschikbare ruimte wordt bepaald door de grootte van het browservenster.  
 
 
 
Tip 1 Als een frame altijd even groot moet blijven, dan moet je deze voorzien van een waarde in 
Pixels en het andere frame selecteer je ‘Relative’ 
 
Tip 2 Als je Border Width op 0 en Borders op No zet, dan zijn de afscheidingsranden tussen de 
frames niet zichtbaar in de browser! 
 
Tip 3 Border Width-instellingen geven een verschillend resultaat in Internet Explorer en Netscape 
Navigator.  Als je verschillende Borderbreedten hebt opgegeven voor een geneste frameset ( een 
frameset in een frame), dan zijn die in Internet Explorer te zien. In Netscape ziet de pagina er zo uit 
als in Dreamweaver, dus zonder de opgegeven verschillen.  Dus als je met frames werkt test dan 
altijd je pagina in meerdere browsers. 
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Frame-properties 
Klik binnen het kader van het betreffende frame in het Frames-tabblad om een frame te 
selecteren.Als een frame is geselecteerd, verschijnt een stippellijn langs de binnenzijde van de rand 
om het frame in het document. In de Frames-inspector wordt de rand om het geselecteerde frame 
donkerder. 
 

 
 
Nu  kun je in de Property-inspector de eigenschappen van het frame bewerken. 
 
 Frame Name  Geef hier het frame een naam. ( zie hyperlinks & targets ) 
 Src  Selecteer hier het html-document dat in het betreffende frame moet worden geopend.  
 Scroll  Geef hier aan of er een scrollbar moet verschijnen als de inhoud van het frame (het html-

document) niet past in de ruimte die het frame heeft. 
 No Resize  Als je deze optie activeert, dan kan de gebruiker in de browser de grootte van het 

frame niet veranderen met klik & sleep op de rand van het frame.  
 Borders  Hier heb je dezelfde keuze als bij de frameset-properties.  De optie die je hier selecteert 

heeft voorrang boven de frameset-instelling.  
 Border Color  Selecteer een kleur voor de afscheidingsrand van het frame.  
 Margin Width  Geef hier de ruimte in tussen de inhoud en de linker- en rechterrand van het 

frame.  De waarde is in pixels.  
 Margin Height   Geef hier de ruimte op tussen de inhoud en de boven- en onderrand van het 

frame.  De waarde is in pixels. 
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Preview in Browser 
Elke keer als je een Preview in Browser opvraagt voor een frameset, dan zie je een dialoog venster 
waarin Dreamweaver 'vraagt' of je alle documenten wilt bewaren die te maken hebben met de 
frameset.  Klik OK. 
 

 
 
 
Hyperlinks en Targets 
Als je een pagina met frames hebt gemaakt, kun je een hyperlink in het ene frame gebruiken om in 
een ander frame een nieuw html-document te openen. Voorwaarde is dat alle frames in de frameset 
een naam hebben. De naam van een frame mag geen spaties, streepjes of leestekens bevatten.  Een 
under_score mag wel.  Elk frame in een frameset moet een unieke naam hebben. Geef frames in 
een frameset nooit de naam van de standaardtargets voor een link.  Dus niet: top, blank, parent of 
self. 
 
Selecteer het element waarop je de link wilt definiëren en open de Property-inspector.  Definieer een 
hyperlink. 
 
In het pop-upmenu bij Target selecteer je het frame waarin de gelinkte pagina moet moet worden 
geopend.  De namen van alle frames in de verschijnen onderaan in het pop-up menu bij Target. 
(‘inhoud’ is geselecteerd) 
 

 
NoFrames Content 
Er zijn oude en tekstgebaseerde browsers die geen frames ondersteunen.  Als u deze gebruikers ook 
wilt ondersteunen, dan kunt u in Dreamweaver zogeheten NoFrames Content definiëren.  Deze wordt 
getoond in een browser die geen frames ondersteunt. 
 

1. Selecteer Modify > Frameset > Edit NoFrames Content 
2. Het Document-venster wordt leeggemaakt en bovenin verschijnt in een grijze balk 

'NoFrames Content'. Je kunt nu een kleine ‘verontschuldiging’ typen voor het feit dat je 
bezoeker niets te zien krijgt. 

3. Selecteer opnieuw Modify >Frameset > Edit NoFrames Content om weer terug te keren 
naar de pagina met frames. 
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12 - Kleur op het web 
 
Waarom ziet een afbeelding er thuis op de computer goed uit en als je dezelfde site ergens anders 
gaat bekijken ineens niet.  
 
Dit is een combinatie van drie factoren : 
 De browser  (internet explorer, firefox of netscape navigator) 
 De beeldschermkaart (ook wel videokaart ) 
 Het platform ( Pc of Mac ) 

 
De computer is in deze de boosdoener : als jij thuis op een ‘perfect’ systeem websites en content 
ontwikkeld dan moet de gebruiker als die exact hetzelfde wil zien eigenlijk eenzelfde systeem thuis 
hebben. Dat is vaak niet het geval dus je moet als ontwerper weten wat voor syseem jou doelgroep 
heeft. 
 
De doelgroep bepaalt de te gebruiken technieken 
 
De doelgroep bepaalt de standaard. 
Er waren eens . . .  256 kleuren en een beeldschermformaat van 14 inch  (480 x 600 pixels), als je nu 
een goedkope computer koopt dan is de monitor minstens 17 inch (min 768 x 1024) en kun je je 
kleuren instellen op miljoenen kleuren 
 
De betekent dat de beperkingen die de webdesigner op dat gebied (beeldschermen) tegen het lijf liep 
nu geen rol van betekenis meer spelen. 
 
Dit neemt overigens niet weg dat testen van sites op verschillende systemen, in  verschillende 
configuraties geen overbodige luxe is : dit blijft een belangrijk onderdeel van de ( technische) 
vormgeving van een site. 
 
Drukwerk & beeldscherm 
Een ontwerper (2D) heeft te maken met verschillende 'podia' voor zijn werk. De 2 belangrijkste podia 
zijn op dit moment papier (drukwerk) en beeldscherm (cdroms, websites & tv).   
 
Deze 2 podia hantereren verschillende manieren van kleur gebruik en beheer. Drukwerk wordt , ook 
al is het op de computer ontworpen, met behulp van inkt zichtbaar. De basis kleuren die bij drukwerk ( 
printen ) een rol spelen zijn Cyaan, Magenta, Yellow en Black  (CMYK). Als je dus op de computer ( 
beeldscherm) aan het ontwerpen bent moet je je er dus rekenschap van geven dat wat jij op je 
monitor ziet misschien niet correspondeert met wat er uit de printer komt.  Wit is bv. geen kleur die in 
de cartridge zit, wit is de kleur van de ondergrond, het papier en zwart wordt gebruikt om om samen 
met een CMY combinatie de helderheid / donkerte van de kleur te maken.  
Niet alle kleuren die jij op een monitor ziet kan de printer dan ook maken met behulp van zijn 
kleurencartridge. 
 
Het beeldscherm maakt namelijk gebruik van een RGB ( Rood, Groen & Blauw ) kleurensysteem, met 
onder ander als eigenschap dat als je 100% Rood 100% Groen en 100% Blauw mengt dat je wit krijgt 
(zwart is 0% R 0% G en 0% B) 
 
Als je voor het beeldscherm (internet) ontwerpt heb je te maken met het RGB 
kleurenpalet. 
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In Photoshop kun je, werkend in de RGB modus,  de RGB kleuren instellen op een schaal van 0 tot 
256. Elke kleur heeft dus 256 nuances, bij elkaar zijn dat 256x256x256 = 16.777.216 
kleurencombinaties.  
 
Beeldschermkaart 
Er is veel mogelijk maar in het geval van internet zitten er een aantal (kleine) beperkingen beperking 
in de combinatie beeldscherm(kaart) en browser. Grosso modo: hoe beter de videokaart des te meer 
kleurnuances er op de monitor getoond kunnen worden. 
 
Een  8 bits kleuren kaart kan in totaal maar 256 kleurnuances laten zien, een 16 bits kleurenkaart kan 
al 65.536 (hoge kleuren) kleurnuances laten zien en een 32 bits kleuren kaart kan in totaal 
16.777.216 kleurnuances laten zien (vgl. met photoshop); True-color (32 bits) kan in totaal 
4.294.967.296 kleurnuances laten zien. 
Deze waardes vindt je ook terug bij je beeldscherminstellingen. (klik met je rechter muisknop op het 
bureaublad en kijk onder eigenschappen) 
 
De Hexadecimale waarden & het websafe palet 
De browsers gebruiken een kleurenmodel waarin elke primaire kleur wordt opgebouwd op basis van 
de hexadecimale waarden: 00, 33, 66, 99, CC en FF.   De waarde 00 staat voor het totaal ontbreken 
van kleur, de waarde  FF is de maximale hoeveelheid kleur.  De met de hexadecimale waarden 
corresponderende RGB waarden zijn: 0, 51, 102, 153, 204 en 255.  In totaal zijn dit 6 x 6 x 6 = 216 
kleuren 
Deze 216 kleurenvormen het websafe kleuren palet: Op elke combinatie van Browser, videokaart en 
platform (mac/PC) zien deze kleuren er goed uit ( in de alinea de doelgroep bepaalt de standaard was 
al te lezen dat je hede ten dage met deze beperking geen rekening hoeft te houden) 
 
Elke afzonderlijke kleur (van het RGB palet) wordt in deze schrijfwijze bepaald door een van de 
bovenstaande  letter / cijfer combinaties De kleur rood is in deze schrijfwijze #FF0000", de waarde 
voor groen is #00FF00, wit is #FFFFFF  en zwart is  #000000 
 
Overigens kun je met dit hexadecimale stelsel ELKE kleur van het RGB palet maken. Dreamweaver 
laat in zijn kleuren-kiezer altijd het web-safe palet zien. 
 
In het voorstel voor HTML (zoals dat indertijd is ontwikkeld) zijn naast de nummers ook 16 algemeen 
bekende namen van kleuren gestandaardiseerd  De Netscape Navigator en internet Explorer 
herkennen de kleurnamen automatisch en passen ze ook toe. De 16 komen overeen met de 
standaardkleuren die door het Windows VGA-palet worden ondersteund; hier komen ze voor de 
laatste keer: Default, Black, White, Green, Maroon, Olive, Purple, Gray, Yellow, Lime, Aqua, Fuchsia, 
Silver, Red, Blue & Teal. 
 
 
 
 
Nog even doorsurfen op de wikipedia . . .  
Meer kleuren:   http://nl.wikipedia.org/wiki/Lijst_van_HTML-kleuren  
Kleur algemeen:  http://nl.wikipedia.org/wiki/Kleur 
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13 - Afbeeldingen op het web 
 
Een van de leuke kanten van het WWW is het feit dat je er met afbeeldingen kan werken. Deze 
afbeeldingen kunnen een rol van betekenis spelen als het erom gaat een boodschap te 
communiceren, maar ze kunnen ook hinderlijk zijn doordat het downloaden van de data te lang duurt.  
Het is de kunst om de balans te vinden tussen de kwaliteit van de afbeelding en de bestandsgrootte. 
 
Er zijn twee standaard bestandsformaten die door ALLE browsers herkend en afgebeeld kunnen 
worden: GIF en JPEG (jpg).   
 
De keuze tussen deze twee formaten is afhankelijk van het soort afbeelding en de toepassing op de 
webpagina. 
 
De gouden regel  
Door de gebruikte compressie techniek is het GIF bestand het best geschikt is voor de weergave van 
grafisch werk (kleurvlakken en met een beperkt kleurenpalet) en de JPG compressie leent zich het 
best voor fotografisch werk. (kleurnuances en kleur verlopen). 
 
GIF-compressie 
Toen de regels van het Web werden gespecificeerd, was dit het enige bestandsformaat dat in een 
webpagina afgebeeld kon worden. Inmiddels is er dankzij de opkomst van het JPEG-formaat en alle 
beschikbare plug-in's veel meer mogelijk op het web. 
 
Toch is het Graphics Interchange Format, of kortweg GIF, nog steeds het meest toegepaste 
bestandsformaat.  (de belangrijkste reden is dat je er zeer kleine bestanden mee kan maken die 
zonder plugin bekeken kunnen worden) 
 
Het GIF-formaat leent zich het beste voor logo's en afbeeldingen die niet zo precies hoeven te 
worden gereproduceerd.  Foto's waarbij de details en kleurverlopen getoond moeten worden, zijn 
minder geschikt. (gebruik JPG) De 256 Kleuren van het GIF-palet zijn ontoereikend om al de nuances 
weer te geven en de compressie werkt ook niet optimaal.   Een GIF-bestand comprimeert foto's dan 
ook altijd slechter dan JPEG. Voor puur grafische afbeeldingen is GIF echter onovertrefbaar.  Denk 
hierbij aan logo's of ‘koppen’ die in een specifiek lettertype weergegeven moeten worden. 
 
256 kleuren 
Het GIF-formaat ondersteunt geindexeerde bitmap-aflbeeldingen met een kleurdiepte  
tot  8-bits of 256 kleuren.  Meer is niet mogelijk, minder wel.   
Des te minder kleuren er in een bestand gebruikt zijn, des te compacter kan het GIF opgeslagen 
worden. 
 
Interlacing 
Het GIF-bestandsformaat kan 'in stappen' ingelezen worden.  Daardoor 
treedt tijdwinst op aangezien men al snel een idee krijgt van het eindresultaat. 
Dit effect heet interlacing. 
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Transparancy 
Transparancy maakt het mogelijk om een of meerdere kleuren uit het palet van de GIF-afbeelding 
letterlijk weg te halen.  Dat heeft tot gevolg dat de achtergrond er 'doorheen' komt.  Deze optie is een 
zegen voor de webdesigners want het biedt enorm veel creatieve mogelijkheden.  Aflbeeldingen 
kunnen daardoor 'vrijstaand' in een achtergrond geplaatst worden.   
 
En een transparante afbeelding van bijvoorbeeld 1 x 1pixel grootte kan gebruikt worden om een 
specifieke afstand in de HTML-opmaak vast te leggen.  Deze truc wordt veel toegepast om bv in een 
tabel cellen en kolommen op maat te houden 
 
 
JPEG 
Het JPEG-compressieformaat is opgesteld door de Joint Photographic Experts Group en heeft ook 
zijn 'roots' in de grafische industrie. Netscape is ermee begonnen om JPEG te ondersteunen in zijn 
webbrowser.  
In den beginne . . . was Netscape de enige browser die dit bestand 'on-line' kon tonen.  De 
toenmalige meestgebruikte browser Mosaic (versie 1.x) had echter problemen met dit nieuwe 
bestandsformaat.  Alleen met behulp van een apart hulpprogramma kon de afbeelding op het scherm 
getoond worden. Op de Macintosh werd hiervoor JPEG-view ingeschakeld. 
Inmiddels ondersteunen alle belangrijke webbrowsers het JPEG-formaat. (en is Netscape nagenoeg 
van het toneel verdwenen) 
 
Voor het afbeelden van gedetailleerde foto's is het JPEG-bestandsformaat de juiste keuze. 
 
Beeldkwaliteit van hoogst tot laag 
Aangezien in een foto elke pixel een andere kleurwaarde heeft, is het GIF bestands formaat lang niet 
zo effectief als JPEG.  Dat komt omdat het JPEG compressie-algoritme niet naar groepen pixels 
zoekt, maar naar variaties van pixels die in een groep staan.  Aangezien de mate van compressie in 
JPEG instelbaar is, zal het algoritme grotere of kleinere variaties accepteren.Om toch een acceptabel 
resultaat te krijgen zal de compressie er wel toe leiden dat er beeldinformatie weggegooid wordt.   
 
JPEG compressie en progressie 
Ook het JPEG-bestandsformaat kent een techniek waardoor de opbouw van de afbeelding 
gebaseerd, of beter gezegd, progressief wordt ingelezen.   
Als zo'n 15 procent van het beeld is ingelezen, krijgt men al een redelijke indruk van de complete 
afbeelding.  
 

LET OP: Als een JPEG-bestand voor de tweede of derde keer als JPEG weggeschreven 
wordt, treedt er namelijk een toenemende degradatie van de beeldkwaliteit op.   
 
Bewaar het origineel! 

 
 
 
Bestandsgrootte 
Hoe minder pixels een afbeelding groot is des te kleiner is het bestand in (kilo) Bytes en des te sneller 
kan het gedownload worden.  Echter het oog wil ook wat, nietwaar?  Het vinden van de juiste balans 
is een lastig karwei.   
Maar de grafische software programma's bieden steeds betere oplossingen voor dit probleem.  Zowel 
Macromedia Fireworks als Adobe Photoshop bieden zeer goede en snelle methode’s om 
afbeeldingen voor het web te bewerken en op te slaan. 
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PNG bestandsformaat 
PNG (Portable Network Graphics) is een nieuw bestandsformaat waarin de beste eigenschappen van 
GIF en JPEG zijn verenigd.  PNG wordt al door enkele tekenprogramma's ondersteund zoals Adobe 
Photoshop ondersteunt.  In Macromedia Fireworks wordt PNG zelfs als standaard formaat voor alle 
beeldbewerkingen gebruikt. 
 
Het belangrijkste voordeel van de PNG compressie methode is dat opslag in 32-bits kleuren mogelijk 
is (dit betekent een extra kanaal voor transparantie), in tegenstelling tot de limiet van 8 bits bij GIF, 
terwijl nog steeds een enorme compressieratio wordt bereikt.  PNG-bestanden zijn 30% kleiner dan 
vergelijkbare TIFF-bestanden.   
Bovendien heeft PNG het belangrijkste voordeel van TIFF overgenomen - compressie van 
documenten zonder enig gegevensverlies.  PNG is een belangrijke verbetering ten opzichte van het 
zowel het GIF als JPEG-formaat.  
 
De integratie met  alle webbrowsers is echter nog niet volledig. 
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14 - Beeldbewerken met Adobe Photoshop 
 
Het programma Photoshop is een zg. beeldbewerkings programma: Dit programma is er speciaal 
voor om foto’s te bewerken. In dit programma kun je tot op de pixel nauwkeurig een beeld bewerken. 
De onderstaande tutorial gaat niet in detail in op alle onderdelen van het programma, maar behandelt 
een aantal basis functies & vensters en verteld ook waar je deze kan vinden in het programma. 
 
Hieronder vindt je een screendump van het proramma, met boven het beeld de werkbalk met de 
onderdelen: File, Edit, Image, Select, Filter, View, Window & Help. Onder deze knoppen vindt je alle 
fucnties van het programma. 
 

 
 
Verder zie je het geopende document, Duckey.psd (100% Text, RGB), de laag Text is geselecteerd, 
het lagen venster met daarin, in lagen zichtbaar, de opbouw van de afbeelding. Links in beeld staat 
de Toolbox , met daarin alle gereedschappen (het penseel-gereedschap is geselecteerd). De opties, 
je ziet de ‘opties’ van het geselecteerde gereedschap; grootte, modus, transparantie etc. 
 
En nog een aantal paletten voor kleur, navigatie en ‘history’. 
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BESTANDEN 
Nieuw, Openen, Importeren, Opslaan & Save for web . . . 
 

 
 
 
New . . . 
 

                             

Onder ‘File’ kun je op meerdere manieren met een 
nieuw document aan het werk gaan : 
 
• Klik op ‘New’ en je krijgt een dialoog venster 

waarin jezelf de waarden voor het document in 
moet voeren 

 
• Klik op ‘Open’ en je kunt een al bestaand 

document openen en verder bewerken. 
 
• Klik op ‘Import’ en je kunt door twain te 

selecteren met behulp van een scanner een 
afbeelding importeren ( er moet dan wel een 
scanner geinstalleerd zijn.) 

 
• Klik op ‘Save for web’ om een geopend 

document te optimaliseren voor het internet. 
 
 
Hier kun je ook opslaan, opslaan als & kopie 
opslaan. 
 
 
 
Onder Edit > preferences kun je een aantal basis-
instellingen maken voor het programma. 

Als je nieuw klikt krijg je het volgende dialoog 
venster met de volgende opties : 
 
1. Name geef het bestand een naam 
2. Width/Height geef de afmetingen van het 

bestand aan in pixels (beeldscherm) of 
centimeters(print)  

3. Resolution 72 Pixels-Inch voor het 
beeldscherm, een hogere waarde voor 
print 

4. Mode RGB voor een kleurafbeelding, 
CMYK voor print 

5. Contents kies of de achtergrond van je 
nieuwe document wit , ransparant of een 
kleur naar keuze moet zijn  

 
Klik OK 
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Importeren – WIA - Windows Image Acquisition 
 

 
 
Als je onder File > Import > WIA support kiest, dan heb je de in dit menu de mogelijkheid* een 
scanner of camera te selecteren om afbeeldingen te digitaliseren & importeren. 
 
* indien scanners of camera drivers geinstalleerd zijn 
 
 
Open . . .  
Onder openen kun je op je harde schijf gaan zoeken (bladeren) naar bestanden die je hebt 
opgeslagen. Photoshop kan een hele brede range van bestanden openen : 
PSD , JPG , BMP , GIF , TIF, TARGA , EPS , AI , PICT (mac) , PNG , (dit zijn wel de belangrijkste) 
 
 
opslaan (PSD, JPG, GIF etc.) 
Onder opslaan kun je kiezen uit Save. . . (wijzigingen in het bestaande document opslaan) of Save 
As. . . ( dan maak je een nieuw document , dit moet je doen als je het orgineel intact wilt houden). 
 
 
LET OP 
Bewaar van een digitaal bestand of nieuw werkstuk altijd het orgineel als PSD of TIFF.  
 
Sla je orgineel nooit op als JPG of GIF want de compressie zorgt voor kwaliteits verlies en dit 
verlies is NIET terug te draaien. 
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Save for Web  
Een buitengemeen bruikbare functie voor de moderne webdesigner of imagecontroller. Met deze 
fuctie kun je direct vanuit je werkbestand (PSD) exporteren als JPG, GIF of PNG. De extra plussen 
zijn: 
 
De lagen hoeven niet eerst samengevoegd te worden 
De modus van de psd hoeft niet gewijzigd te worden 
Transparantie blijft behouden (gif & png ) 
Je kunt de verschillende formaten goed met elkaar vergelijken ( wat is mooier/kleiner gif of jpg) 
Je kunt de afbeelding zeer goed optimaliseren. 
 
Het gebruik van deze functie is verplicht voor webdesigners. 
 

 
 
In het bovenstaand voorbeeld wordt Ducky als gif-bestand met een palet van 8 kleuren opgeslagen. 
Dit resulteert in een klein bestand van 5,5 Kbyte MAAR met slechte beeld-kwaliteit . . . .
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AFBEELDING 
 
Image > Mode 
 

 
 
Soms kun je een van internet gedownload bestand binnen photoshop niet bewerken; de kans is vrij 
groot dat de ’modus’ van dat bestand niet RGB is. Bij een GIF-bestand staat de modus namelijk op 
‘Indexed Color’; switch naar Image > mode > RGB en je kunt verder werken. 
 
Image > Adjustments 
Hier kun je diverse instellingen maken om je beeld te optimaliseren. 
 

 

Onder afbeelding kun je een aantal 
instellingen maken of veranderen in het 
bestand. 
 
Bij de Modus kun je switchen tussen  
 
• RGB (voor het beeldscherm) 
• CMYK (voor de printer)  
• Grijswaarden  voor een zwartwitfoto  
• geindexeerde kleur (GIF afbeelding) 

 
• Lab & multichannel . . 
 
 

De belangrijkste zijn 
 
• Brightness/Contrast - Helderheid & contrast 
• Color Balance - Kleurbalans 
• Hue/Saturation - Kleurtoon & verzadiging 
 
 
Onder Levels & Curves kun je  vergaand aan je 
beeld sleutelen maar dat veronder-steld wel een 
goede kennis van digitale beeldbewerking en het 
programma Photoshop. 
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Helderheid en contrast   
Met behulp van van de ‘schuifjes’ kun je de instellingen maken. 
Voor kleurbalans en ander opties krijg je een vergelijkbaar dialoog venster 
 

 
 
 
Afbeeldingsgrootte 
Hier kun je de instellingen van het geopende document aanpassen. 
In dit dialoogvenster kun je door nieuwe waarden in te voeren bij de verschillende onderdelen ook 
een goed inzicht krijgen in het verband tussen Pixels, Centimeters (Inches) en Resolutie (PPI) 
 
Hieronder zie je naast elkaar de Pixelafmeting van een afbeelding en de Afdrukgrootte. Hoe deze 
twee zich tot elkaar verhouden wordt uitgedrukt in de Resolutie 
 

 
 
Beelden op het web (het beeldscherm): Vergeet resolutie denk PIXELS 
 
In drukwerk en bij het printen is de resolutie (het aantal pixels dat je uiteindelijk per inch / centimeter 
afdrukt) zeer belangrijk voor het eindresultaat. Op het web – het beeldscherm – speelt de resolutie 
geen rol. 300 pixels zijn 300 pixels; de instellingen van de monitor bepalen hoe groot de afbeelding 
getoond wordt. Een plaatje van 300 x 300 pixels ziet er op een monitor met een instelling van 1280 x 
1024 pixels kleiner uit dan op een monitor met een instelling van 800 x 600 pixels.  
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Layer >  
Onder deze optie vindt je de instellingen die met Photoshop lagen te maken hebben. 
 

 
 
 

                                  

In het programma Photoshop kun je een 
complex beeld samenstellen door meerdere 
meerdere lagen beeld en text tegelijkertijd te 
gebruiken in combinatie met de dekking 
(transparantie) van een laag. 
 
Let op  Heel veel lagen betekent  echter dat je 
document zwaarder (Kb / Mb) wordt. En de 
computer moet meer en langer rekenen. . . 
 
Hieronder staat het lagen venster zoals dat eruit 
ziet met meerdere lagen (de T laag wordt 
aangemaakt als je met het text tool werkt ), 
linksonder staat het lagen venster zoals dat eruit 
ziet bij een document waarvan de lagen zijn  
‘samengevoegd ’, of zoals het eruit ziet als je 
een plaatje zonder lagen hebt geopend 
 
Experimenteer ook eens met het 'pulldownmenu'  
in het lagen-palet en kijk wat de opties onder -
normaal- doen. 
 
De lagen kun je met het oogje  ‘aan’ en ‘uit’ 
zetten en door middel van ‘klikslepen’  kun je 
volgorde van de lagen wijzigen. 
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View, Window & Help 
 
Onder View (weergave) kun je instellen hoe Photoshop de afbeelding in het programma laat zien. 
Zoom In, Zoom Out ,  
Actual pixels  - werkelijke pixels;  bestand op 100%; zo groot als het in een browser te zien zal zijn) ,  
Rulers - Linealen: zet deze optie aan als je met hulplijnen wil werken : je kunt namelijk dmv. 
klikslepen  hulplijnen uit de linealen trekken) 
Show > Grid - Raster; instellingen voor raster, hulplijnen en linealen maak je onder . . . . Edit > 
preferences > Units & Rulers / Guides & Grid 
 
 
Onder het Window (venster) kun je alle Photoshop-paletten, tools en vensters openen of 
sluiten. 
 
Gebruik Help (F1) als je thuis bent of als de docent geen aandacht aan je besteedt. 
 

              
 
 
 
 
 



 69

15 - Scannen bij de BeeldFabriek 
 
Bij de BeeldFabriek kun je analoog (foto’s, knipsels, text, etc. . .) materiaal met behulp van een 
scanner digitaliseren. Het is echter niet mogelijk op elke PC te scannen; per digitaal lokaal is er een 
scanner aanwezig. Om materiaal te scannen zul je dus achter de desbetreffende PC moeten gaan 
zitten. 
 
Start Photoshop op op de scan-computer; als Photoshop is opgestart, ga dan naar File > import > . . 
. .. Hier kun je een van de geinstalleerde randapparaten selecteren (scanners, digitale fototoestellen 
ed.)  
 
Terminologie & tips 
 
Type orgineel  
Bij sommige scan-programma’s kun je instellen wat voor ‘soort’ orgineel je gaat scannen. Foto-
glanzend, foto-mat, tijdschrift, tekst, krant, inktjet-afdruk, afdruk, orginele tekeningen. Een mooie 
scherpe kleurenfoto is het beste uitgangspunt voor een goede scan. 
 
Beeldcontrole  
Soms bestaat de mogelijkheid in het scanprogramma je beeld te corrigeren. Laat alles staan zoals 
het staat (default) en bewerk het beeld indien nodig in Photoshop, in Photoshop heb je namelijk een 
veel betere controle over het beeld dan binnen de meeste scan programma’s.  
 
Afmetingen  
Let er bij deze instellingen op dat Beeldresolutie, pixels & Centimeters (Inches) aan elkaar 
gerelateerd zijn dus dat de ene instelling de andere beinvloed.  
  
Resolutie  
is de verhouding tussen centimeters (inches) en het aantal pixels. Het aantal dots per inch instellen: 
DPI  (Dots per Inch) is van toepassing op printers. PPI  (Pixels per Inch) is van toepassing op een 
gedigitaliseerd beeld. In de volksmond worden de twee door elkaar gebruikt maar een photoshop 
bestand (een gedigitaliseerde foto oid.) is opgebouwd uit pixels en niet uit dots.  
 
Resoluties 
72  PPI: Beeldschermresolutie 
150 PPI: Is een goede resolutie om met een kleurenprinter een mooie afdruk te maken. 
300-400 PPI: Scherp genoeg voor drukwerk maar bestanden zijn erg groot. 
 

TIP: Werk altijd met pixels als je iets voor een beeldscherm gaat maken, werk altijd met 
centimeters & DPI als je iets voor drukwerk of print gaat maken. 

 
Tip: Bedenk van te voren waarvoor je een bestand gaat gebruiken. Als je einddoel een foto is 
van 300x300 pixels dan heeft het geen zin de foto op een formaat van 2000 x 2000 pixels in te 
scannen. Zorg er wel voor dat je enige speelruimte hebt om de foto bij te werken; een te klein 
gescande foto vergroten in photoshop leidt tot kwaliteitsverlies. 
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16 - Formulieren 
 
Het Formulier is het belangrijkste middel om op het WWW informatie aan de computer te voeren.  
 
Je kunt de bezoeker van jou site om informatie vragen (adresgegevens, enquetes) tegelijkertijd kan 
de bezoeker middels het formulier ook gericht informatie uit het systeem halen (zoeken, bestellen) 
 
Hoe deze uitwisseling van  informatie ingezet kan worden varieerd per site. Een aantal voorbeelden: 
www.comcol.nl (bestellen); www.ns.nl (spoorboekje); www.beeldfabriek.org (aanvraagformulier), 
www.google.nl (zoeken), enquetes en ga zo maar door. 
 
Het formulier bestaat uit 2 onderdelen 
 
1 - De form tag   <form name=" " method=" "  action=" ">......</form> 
 
 name  

een naam, geef het formulier een naam, zeker als je het met javascript (behaviours) wilt 
aanspreken  

 method 
GET of POST hoe moet de formulier informatie naar de server gestuurd worden? Meestal POST 
hetzij andersaangegeven.  

 action 
Hoe moet de informatie uit een formulier verwerkt worden? Meestal verwijst de action naar een 
script, een programma op de server dat de informatie uit het formulier kan lezen en verwerken. 
PHP, ASP en CGI zijn de bekendste en meest gebruikte scripts op het internet 

 
Ga in dreamweaver naar : 
View > Visual Aids >  Invisible Elements (aanvinken) en ga vervolgens naar Insert > Form 
 
Nu zie je het onderstaand kader verschijnen op je webpagina; je moet er voor zorgen dat de input 
types in het kader (HTML: tussen de form tags) staan anders werkt het formulier niet 

 
 
2 - De Input types  <input type=" "  name=" "  value=" ">  
 
Het type bepaalt de wijze waarop de informatie verzameld wordt, naam en value bepalen de 
informatie die door het CGI / java script verwerkt en doorgestuurd wordt.  
 
Geef een herkenbare naam (name) zodat de bijbehorende geselecteerde waarde (value) ook direct 
goed geinterpreteerd kan worden. 
Als je een bv. formulier op een site hebt staan waarin adresgegevens moeten worden ingevuld; als je 
het goed doet dan krijg je informatie terug als dan krijg je een keurig overzicht van de ingevulde 
gegevens per email 'thuis'. 
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De input types 
 

 
 
 
De input-types zijn de verschillende mogelijkheden om informatie van de site-bezoeker te 
verzamelen, in dreamweaver kun je met behulp van de properties de eigenschappen van de input 
types definieren. 
 
kies in Insert > Form Objects, en selecteer een input type. 
 
Tip 
gebruik een tabel om van form objects (input types) en begeleidende texten een knap formuliertje te 
maken. Zorg dan dat de hele tabel met de daarin geordende form objects tussen de <form> tags 
staat; het maakt voor de functionaliteit niet uit dat er andere html elementen tussen formtags staan. 
  
  

<input type="text" name=""> 

<input type="radio" name="radiobutton" value="keuze A"> 

<input type="checkbox" name="janee" value="ja ik wil"> 

<select name="menu123"> 
<option value="1" selected>een</option> 
<option value="2">twee</option> 
<option value="3">drie</option> 
<option value="3">drie</option> 
</select> 

<select name="menu123" size="3"> 
<option value="1">een</option> 
<option value="2">twee</option> 
<option value="3">drie</option> 
<option value="3">drie</option> 
</select> 

<input type="file" name="filefield"> 

<input type="hidden" name="to" value="info@kuub3.nl"> 

<input type="submit" name="submit" value="verstuur formulier"> 
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 . 
 
Stylesheets - basis (in ontwikkeling) 
 
CSS – een belangrijk onderdeel in de vormgeving van websites. In de basiscursus wordt 1 à 2 lessen 
aandacht besteed aan dit onderwerp. Het gaat hierbij om de  basisprincipes van vormgeven met 
Dreamweaver en CSS.  
 
Lees je vast in op: http://nl.wikipedia.org/wiki/Cascading_Style_Sheets 
 
 
Stylesheets - vervolg (in ontwikkeling) 
 
CSS – een belangrijk onderdeel in de vormgeving van websites. In de vervolgcursus wordt uitgebreid 
(ongeveer 5 à 6 lessen) aandacht besteed aan dit onderwerp. Zowel de  basisprincipes van het 
vormgeven met Dreamweaver en CSS als het zelf typen, plakken en knippen van Stijlen. 
 
Lees je vast in op: http://nl.wikipedia.org/wiki/Cascading_Style_Sheets 
 
 
Video for the web – vervolg (in ontwikkeling) 
 
Helemaal ** HOT ** sinds de overname van Youtube door Google . . in ontwikkeling 
 
Lees je vast in op: http://nl.wikipedia.org/wiki/Streaming_video 
 


